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 چکیده

که پرسشنامه اختلال اضطراب     GAD-7این پروژه کارشناسی با هدف ارزیابی پایایی و روایی پرسشنامه 

 Mental health data of 776"درجه ای است، بر روی دیتاست  1آیتمی با مقیاس لیکرت  7فراگیر 

Mexican medical students"  از سایتFigshare  دانشجوی  777انجام شد. جامعه آماری شامل

رکورد رسید.  759های گمشده، نمونه نهایی کاهش یافته و  به پزشکی مکزیکی بود که پس از حذف داده 

های آماری استفاده شد. برای تحلیل  SPSSافزار تحلیلی بود و از نرم  -شناسی پژوهش کمی و توصیفی روش 

و  (EFA)و روایی سازه با تحلیل عاملی اکتشافی  CVIو  CVRهای در بخش روایی، روایی محتوایی با شاخص

ی بینی افکار ترک تحصیل ارزیاببررسی شد. روایی ملاکی نیز با رگرسیون خطی برای پیش (CFA) تأییدی 

ریب ضبازآزمون با -شده، آزمونسازی با همبستگی تعدیلخ، روش نصفگردید. در بخش پایایی، آلفای کرونبا

محاسبه شد. نتایج نشان داد که  PHQ-9و  GAD-7بین   همبستگی ضریب با نیز ارزیهمبستگی و هم

GAD-7 های  پایایی عالی و روایی قابل قبول تا قوی دارد، اما آیتمgad5  وgad7 تر هستند و نیاز  ضعیف

ی فرهنگی دارند. این ابزار برای غربالگری اضطراب در دانشجویان پزشکی معتبر است، اما ساز به بومی

ارزی وجود دارد. پیشنهاد  بازآزمون و هم-های آزمون سازی فرضی در روش هایی مانند شبیه محدودیت

 زایش یابد.پذیری اف های طولی و نمونه ایرانی انجام شود تا تعمیم شود مطالعات آینده با دادهمی
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 مقدمه

های علمی و عملی  آوری داده ها نقش کلیدی در جمع گیری مانند پرسشنامه اندازهدر دنیای امروز، ابزارهای 

، که برای GAD-7شناسی و بهداشت. پرسشنامه  اجتماعی، روانهای علوم  ویژه در حوزه نند، بهک میایفا 

سنجش شدت اختلال اضطراب فراگیر توسعه یافته، یکی از ابزارهای رایج غربالگری است. ارزیابی پایایی )ثبات 

ین تضم گیری سازه مورد نظر( این پرسشنامه نه تنها اعتبار علمی پژوهش را اندازهنتایج( و روایی )دقت در 

های پرخطر مانند  های عملی مانند تشخیص زودرس اضطراب در گروه ای برای کاربرد د، بلکه پایهکنمی

     ترین اختلالات روانی است که طبق  آورد. اضطراب عمومی یکی از شایع دانشجویان پزشکی فراهم می

عواقبی مانند کاهش تواند به  میرسد و  می % 94های جهانی، شیوع آن در دانشجویان پزشکی تا  گزارش

عملکرد تحصیلی، افسردگی و افکار ترک تحصیل منجر شود. در ایران، با توجه به فشارهای آموزشی و اجتماعی، 

سنجی  شود، اما عدم ارزیابی روان بیش از پیش احساس می GAD-7نیاز به ابزارهای معتبر غربالگری مانند 

 های غلط منجر شود. گیری تصمیمهای نامعتبر و  تواند به دادهی م

دانشجوی  777بر روی دیتاست شامل  GAD-7این پروژه کارشناسی با تمرکز بر ارزیابی پایایی و روایی 

       ندمان پزشکی مکزیکی انجام شد. انتخاب این دیتاست به دلیل تنوع متغیرهای مرتبط با سلامت روان

PHQ-9  برای افسردگی وEpworth های  نمونه کافی است که امکان تحلیل آلودگی و حجمبرای خواب

های  در جمعیت GAD-7سنجی  کند. مسئله اصلی پژوهش، کمبود ارزیابی روانآماری دقیق را فراهم می

تواند به تشخیص نادرست و هدررفت منابع منجر شود. اهمیت این موضوع در جوامع  دانشجویی است که می

جایی که استرس تحصیلی بالا و دسترسی محدود به متخصصان، در حال توسعه مانند ایران دوچندان است، 

ی، ساز های آلفای کرونباخ، نصف با روش دهد. ارزیابی پایایی نیاز به ابزارهای ساده و معتبر را افزایش می

    تنها نه ، ملاکیروایی سازه و روایی محتوایی، روایی  با روش های ارزی و روایی بازآزمون و هم – آزمون

 رساند. میکمک  نیز های محلی سازی آن برای کاربرد کند، بلکه به بومیعتبار ابزار را تأیید میا

        شود. هدف کلی، ارزیابی کیفیت کلی پرسشنامه اهداف پژوهش به دو بخش کلی و جزئی تقسیم می

GAD-7 سنجد.  ضطراب را میاز منظر پایایی و روایی است تا اطمینان حاصل شود که ابزار به طور دقیق ا

 هبازآزمون شبی - اهداف جزئی شامل تعیین پایایی داخلی با آلفای کرونباخ، بررسی ثبات زمانی با آزمون

، و بررسی روایی PHQ-9و  GAD-7ارزی با همبستگی  های تحصیلی، ارزیابی هم شده بر اساس ترمسازی

 به شرح زیر است: فصل دوم به مبانی این پژوهششود. ساختار  بینی افکار ترک تحصیل می ملاکی با پیش

شناسی پژوهش را شامل  کند. فصل سوم روشنظری اختصاص دارد و مفاهیم روایی و پایایی را توصیف می

های  ها را با خروجی دهد. فصل چهارم یافته های تحلیل توضیح می یری و روشگ نمونهطرح، جامعه آماری، 

SPSS ا ه ها و پیشنهاد گیری، محدودیتدهد. در نهایت، فصل پنجم به نتیجه های آماری ارائه می و تحلیل 

 پردازد. میدر این پژوهش 
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 پرسشنامه یک روایی و پایایی ارزیابی موضوع بررسی اهمیت

 هاپرسشنامه بهداشت، و مدیریت روانشناسی، اجتماعی، علوم هایحوزه در ویژهبه علمی، هایپژوهش دنیای در

 . کنندمی عمل هاداده آوریجمع ابزارهای ترینرایج از یکی عنوان به

 تسؤالا آیا اینکه مانند) است مشابه شرایط در گیریاندازه ابزار نتایج سازگاری و ثبات معنای به  4پایایی

 2یروای که حالی در ،(کنندمی دریافت مختلف هایزمان در فرد یک از یکسانی هایپاسخ همیشه پرسشنامه

 امهپرسشن آیا اینکه مانند) دارد اشاره دارد، را آن گیریاندازه قصد واقعاً که آنچه گیریاندازه در ابزار دقت به

 تضمین ار تحقیق یک علمی اعتبار تنها نه ویژگی، دو این ارزیابی(. دیگری چیز یا سنجدمی را "اضطراب" واقعاً

 . آوردمی فراهم شواهد بر مبتنی هایگیریتصمیم و عملی کاربردهای برای ایپایه بلکه کند،می

 

 روایی و پایایی ارزیابی کلی اهمیت

 بدون یساختمان مانند تحقیق نتایج آن، بدون و است گیریاندازه ابزار هر تپنده قلب روایی، و پایایی ارزیابی

 که دکنمی تضمین پایایی استاندارد، تعریف طبق. اعتماد غیرقابل و ناپایدار اما محکم، ظاهراً – ماندمی پی

 ییروا که حالی در دهد،می نشان ناچیزی تغییر مکرر هایآزمون در آن نتایج یعنی است، "تکرار قابل" ابزار

 اهمیت هاارزیابی این. کندمی گیریاندازه کند،می ادعا که را آنچه و است "دقیق" ابزار که دهدمی اطمینان

 :زیرا دارند

 : هاداده ثبات و دقت تضمین -

 ممکن هاداده ارزیابی، بدون اما کنند،می استفاده هاپرسشنامه از مطالعات %74 از بیش کمی، هایپژوهش در

( پایایی برای) کرونباخ آلفای ضریب مثال، برای. باشند( سیستماتیک یا تصادفی خطاهای مانند) نویز از پر است

 دقت ،4.8 بالای( محتوایی روایی برای) CVI مانند هاییشاخص و است، خوب ثبات دهندهنشان 4.7 بالای

 .شوندیم معنیبی( عاملی تحلیل یا رگرسیون مانند) آماری هایتحلیل ها،این بدون. کندمی تأیید را محتوایی

 

 

 

                                                           
1  Reliability 
2  Validity 
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 : نتایج پذیریتعمیم قابلیت افزایش -

 املیع تحلیل مانند) سازه روایی ارزیابی. یابند تعمیم تر بزرگ جوامع به بتوانند باید معتبر های پژوهش

 ارآمدک( ایران مثل) مختلف های زمینه یا ها فرهنگ در پرسشنامه شویم مطمئن تا ندمی ک کمک( اکتشافی

 .اصلی نسخه در فقط نه است،

 :شناختیروش خطاهای و بایاس کاهش -

 قیقاتتح" به نهایت در که کنند، ایجاد شناختی یا زبانی فرهنگی، های بایاس توانندمی نامعتبر های ابزار 

  %14 از بیش که داد نشان  2421 سال در ای مطالعه . شود می منجر "کننده گمراه نتایج" یا "جعلی

 کل راعتبا امر این که هستند، روایی کامل ارزیابی فاقد پزشکی تحقیقات در شده استفاده های پرسشنامه

 .برد می سؤال زیر را حوزه

 ارابز یک از پژوهش ها، آن بدون: هستند صنعت در "کیفیت کنترل" مانند ها ارزیابی این خلاصه، طور به

 .یابد می تنزل آماتوری نظرسنجی یک به علمی

 

  است؟ ضروری روایی و پایایی ارزیابی چرا

 و عمناب هدررفت از جلوگیری برای ناپذیر اجتناب ضرورتی بلکه است، آکادمیک الزام یک تنها نه کار این

 :از عبارتند کلیدی دلایل. است علمی پیشرفت تضمین

 :نادرست های داده اساس بر غلط های گیریتصمیم از جلوگیری -

 ،"اند اضیر مشتریان" بگوید شرکت یک به محتوایی، روایی بدون مشتری رضایت پرسشنامه یک کنید تصور

 پایایی عدم پژوهش، در. شودمی ناکارآمد های سیاست به منجر امر این. اند خشمگین واقعاً که حالی در

 COSMIN های استاندارد طبق که سازد، نامعتبر را آماری های آزمون و کند ایجاد تصادفی واریانس تواندمی

 .دهند انجام را ها ارزیابی این باید مطالعات %84 حداقل ،(سلامت گیری اندازه ابزارهای برای)

 : کمی تحقیقات کیفیت ارتقای -

 اریسازگ ارزیابی، بدون اما شوند،می ترکیب دیجیتال ابزارهای با اغلب ها پرسشنامه بزرگ، های داده عصر در

 بندی اولویت که کندمی تأکید 2425 سال در گزارش یک. رود می بین از( کاغذی و آنلاین مثل) ها فرمت

 .دهد می کاهش %94 تا را ها نظرسنجی خطای نرخ پایایی، و روایی
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 :علمی و اخلاقی های چالش به پاسخ -

 گانکنند شرکت به آسیب از تا باشند معتبر ابزارها که کنند می الزام( IRB مانند) پژوهش اخلاق های کمیته 

 عدم ،(ISI مثل) مقالات انتشار در این، بر علاوه. شود جلوگیری( نامربوط سؤالات از ناشی استرس مانند)

 شناختی روش ضعف دلیل به معتبر های ژورنال ردهای %25 از بیش – شود می مقاله رد به منجر ارزیابی

 .است

  :ها روش در نوآوری-

 برای مثلاً کنیم، سازی بومی را ها پرسشنامه دهد می اجازه( سازه روایی برای CFA مانند) مدرن های ارزیابی

 .ماند می نابرابر تحقیقات آن، بدون که درآمد، کم جوامع

 انندم – است مضر بالقوه بلکه فایده، بی تنها نه اعتبار، بدون پژوهش زیرا است ضروری کار این نهایت، در

 .بالینی آزمایش بدون دارویی تجویز

 

 جامعه واقعی مسائل با موضوع این ارتباط

 اشتیبهد و اقتصادی اجتماعی، مسائل بر مستقیماً و است دانشگاه دیوارهای از فراتر روایی و پایایی ارزیابی

 امند اجتماعی های بحران حتی و منابع هدررفت ها، نابرابری به تواندمی هاارزیابی  این فقدان. گذاردمی تأثیر

 :واقعی های مثال. بزند

 :اقتصاد و گذاریسیاست در -

 های سیاست باشند، نامعتبر اگر( شهروندی رضایت یا فقر سنجش مانند) عمومی نظرسنجی های پرسشنامه

 های نظرسنجی توسعه، حال در کشورهای در مثلاً،. دارند دنبال به را نادرست بودجه تخصیص مانند غلطی

 4WTP ها زیرساخت در گذاریسرمایه عدم به منجر باشند، داشته پایینی روایی اگر عمومی خدمات برای 

 هاینظرسنجی در نامعتبر های داده که داد نشان 2429 سال در ایمطالعه. کندمی تشدید را نابرابری و شودمی

 یاقتصاد های پرسشنامه ضعیف ارزیابی ایران، در. است کرده ایجاد دولتی های ریزی برنامه در خطا %45 فقر،

 .شود منجر تورم با مقابله در ناکارآمد های سیاست به تواندمی

 

                                                           
1  Willingness to Pay 
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 :درمان و بهداشت در -

 های یصتشخ باشند، نداشته پایایی اگر( بیمار رضایت یا افسردگی هایپرسشنامه مانند) غربالگری ابزارهای

 باشند، نامعتبر اگر بهداشت کارگران توسط محور جامعه هایداده درآمد، کم جوامع در. کنندمی ایجاد غلط

 منابع هدررفت به منجر که دارد، همراه به را( COVID-19 مانند) هابیماری بر نظارت در %94-24 خطای نرخ

 پایین، روایی با( ESQ مانند) بیمار تجربه های پرسشنامه فقیر، کشورهای در مثلاً،. شودمی بالاتر میر و مرگ و

 .دهندمی افزایش را بهداشتی نابرابری و کنندمی مختل را واکسیناسیون های برنامه

 :اجتماعی مسائل و آموزش در -

 شیآموز های سیاست به توانندمی نامعتبر های پرسشنامه آموزان،دانش رضایت یا مدارس عملکرد ارزیابی در

 سال در بررسی یک. محروم جوامع در آموزاندانش روانی مشکلات گرفتن نادیده مانند شوند، منجر ناکارآمد

 های ریزیبرنامه در انحراف %45-44 اجتماعی، های نظرسنجی در روایی های خطا که داد نشان 2421

 .دارد بیشتری تأثیر ها اقلیت یا مهاجران بر که کند،می ایجاد حمایتی

 :اجتماعی پایداری بر تأثیر -

 محیطی زیست های کمپین نباشند، معتبر اگر عمومی آگاهی سنجش های پرسشنامه اقلیمی، تغییرات عصر در

 "جعلی صداهای" ارزیابی، بدون آنلاین های نظرسنجی دیجیتال، جوامع در این، بر علاوه. کنندمی اثر بی را

 .کنندمی تهدید را دموکراسی و کرده تقویت را( هابات مانند)

 

 اهداف پژوهش

 کلی هدف

. یستچ دنبال به پروژه که کندمی بیان گسترده طور به و کندمی تعریف را پروژه اصلی چارچوب کلی، هدف

 پایایی منظر دو از  "7 فراگیر اضطراب اختلال پرسشنامه" پرسشنامه کلی کیفیت بررسی کلی، هدف اینجا، در

 به آن ثبات و دقت از اطمینان منظور به؛ است( موردنظر سازه گیریاندازه در دقت) روایی و( نتایج ثبات)

 .ایرانی جامعه در عملی کاربردهای و علمی تحقیقات در استفاده برای معتبر گیریاندازه ابزار یک عنوان
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 جزئی اهداف

 یمتقس عملیاتی های بخش به را پروژه که هستند کلی هدف گیریاندازه قابل و مشخص اجزای  جزئی، اهداف

 روایی هایشاخص یا عاملی تحلیل کرونباخ، آلفای مانند) آماری های روش با باید اهداف این. کنندمی

 .باشند داشته همخوانی( محتوایی

 .رونباخک آلفای ضریب از استفاده با درونی همسانی بررسی طریق از پرسشنامه پایایی تعیین: 4 جزئی هدف

 طور هب پرسشنامه سؤالات آیا اینکه بررسی یعنی پردازد،می پرسشنامه درونی ثبات ارزیابی به هدف این 

 مقادیر که است، منظور این برای طلایی استاندارد 4کرونباخ آلفای ضریب. سنجندمی را سازه یک منسجم

 جداول در آن نتایج و شودمی انجام SPSS افزارنرم با تحلیل این .است خوب پایایی دهندهنشان 4.7 بالای

 .شد خواهد گزارش

 .پرسشنامه هایپاسخ زمانی ثبات بررسی برای  2بازآزمایی پایایی ارزیابی: 2 جزئی هدف

. مانندمی یباق مشابه( هفته دو فاصله با مثلاً) زمانی بازه دو در پرسشنامه نتایج آیا که کندمی بررسی هدف این

 دهندهنشان 4.7 بالای مقادیر که شود،می انجام( ICC یا Pearson مانند) همبستگی ضریب محاسبه با امر این

 . است خوب زمانی ثبات

 CVR هایشاخص و کارشناسان نظرات از استفاده با پرسشنامه محتوایی و صوری روایی ارزیابی: 9 جزئی هدف

 .CVI و

 یاآ و است فهم قابل دهندگانپاسخ برای( صوری) ظاهری نظر از پرسشنامه آیا که کندمی بررسی هدف این

 محتوا روایی نسبت های شاخص. دهدمی پوشش کامل طور به را نظر مورد سازه( محتوایی) آن محتوای

(CVR )محتوا روایی شاخص و (CVI )فرمول طبق. شوندمی محاسبه کارشناس 44-5 حداقل نظر از استفاده با 

 .است مناسب روایی دهندهنشان 4.8 بالای CVI و 4.7 بالای CVR ، 9لوشه

 (.CFA) تأییدی و( EFA) اکتشافی عاملی تحلیل از استفاده با پرسشنامه سازه روایی بررسی: 1 جزئی هدف

 را موردنظر سازه واقعاً پرسشنامه آیا که کندمی بررسی و است روایی ارزیابی بخش ترینپیچیده هدف این

 ،(اردد بعد چند مثلاً) کندمی شناسایی را پرسشنامه زیربنایی ساختار( EFA) اکتشافی عاملی تحلیل. سنجدمی

 هاداده با پیشنهادی ساختار که کندمی تأیید AMOS مانند افزارهایینرم با( CFA) تأییدی عاملی تحلیل و

                                                           
1 Cronbach’s Alpha 
2 Test-Retest Reliability 
3 Lawshe 
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 استفاده منظور این برای( بودن معنادار) بارتلت آزمون و( 7/4 بالای) KMO مانند هاییشاخص. دارد همخوانی

 .است مهم بسیار( فرهنگی هایتفاوت دلیل به) ایران در پرسشنامه سازیبومی برای هدف این. شوندمی

 .موجود استاندارد ابزارهای با پرسشنامه مقایسه طریق از 4ملاکی روایی بررسی: 5 جزئی هدف

( المللیینب استاندارد پرسشنامه یک مانند) دیگر معتبر ابزارهای با پرسشنامه آیا که کندمی بررسی هدف این

 برای ویژه به هدف این(. واگرا روایی) است متمایز غیرمرتبط هایسازه از یا( همگرا روایی) دارد همبستگی

 .است مهم ایمقایسه تحقیقات در ابزار عملی کاربرد از اطمینان

 

 

 

 

 

 

 

 

 

                                                           
1 Criterion Validity 
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 مبانی نظری: فصل دوم
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 گیریاندازه ابزار عنوان به پرسشنامه تعریف 

 تشکیل استاندارد سؤالات از ایمجموعه از که هاستداده آوریجمع برای یافته ساختار ابزار یک پرسشنامه

 تحقیقات در ابزار این. است شده طراحی افراد عقاید یا رفتارها ها، نگرش ها، ویژگی گیریاندازه برای و شده

 امکان سازی، استاندارد دلیل به و رودمی کار به بزرگ های نمونه از اطلاعات گردآوری برای کیفی و کمی

 تبدیل برای مند نظام روش یک پرسشنامه ، 4کرسول تعریف طبق. کندمی فراهم را آماری تحلیل و مقایسه

 .است گیریاندازه قابل های داده به( زندگی کیفیت یا شغلی رضایت مانند) نظری مفاهیم

 پرسشنامه کلیدی های ویژگی

 مانند) استاندارد های مقیاس قالب در معمولاً ها پاسخ و شده طراحی پیش از سؤالات: بودن ساختارمند

 .شوندمی ارائه( لیکرت

 .مشابه شرایط با مختلف مطالعات در استفاده امکان: پذیری تکرار قابلیت

 .گذاری سیاست تا روانشناسی از متنوع، های حوزه در استفاده قابل: پذیری انعطاف

 .کوتاه زمان در دهنده پاسخ زیادی تعداد از داده آوریجمع امکان: کارایی

 

 ها پرسشنامه تکامل و تاریخچه

 ؤالاتس از گالتون فرانسیس مانند دانشمندانی که زمانی گردد،بازمی نوزدهم قرن به ها پرسشنامه از استفاده

 ، 2سنجی روان توسعه با بیستم، قرن در. کردند استفاده شناختی روان های ویژگی بررسی برای مکتوب

 ههد در. کردند ظهور( لیکرت مقیاس مانند) نگرشی های مقیاس و شخصیت های پرسشنامه مانند ابزارهایی

 جایگاه( Google Forms مانند هاییپلتفرم و آنلاین هاینظرسنجی مانند) فناوری پیشرفت اخیر، های

 اجتماعی علوم تحقیقات %74 از بیش که داد نشان 2421 سال در ایمطالعه. است کرده تقویت را ها پرسشنامه

 مانند جدیدی های چالش اما داده افزایش %94 را کارایی که کنند،می استفاده دیجیتال های پرسشنامه از

 .است کرده ایجاد آنلاین دهی پاسخ بایاس

                                                           
1 Creswell, 2020 
2 Psychometrics 
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 ها پرسشنامه انواع

 به انواع این شناخت. شوندمی تقسیم مختلفی انواع به اجرا روش و ساختار هدف، اساس بر ها پرسشنامه

 . دکن مشخص بهتر را خود تحقیق در پرسشنامه جایگاه تا کندمی کمک پژوهشگر

 از عبارتند هاداده  نوع اساس پرسشنامه ، بر انواع: 

 (.ای درجه 5 لیکرت مقیاس مانند) عددی های داده آوریجمع برای: کمی های پرسشنامه

 .عمیق محتوای تحلیل برای باز سؤالات شامل: کیفی های پرسشنامه

  ،از عبارتند تحقیق هدف اساس برانواع پرسشنامه: 

 (.دموگرافیک هایپرسشنامه مانند) جامعه های ویژگی توصیف برای: توصیفی

 (.سازمانی اعتماد سنجش های پرسشنامه مانند) ها نگرش و عقاید سنجش برای: نگرشی

 (.غذایی عادات های پرسشنامه مانند) رفتارها بررسی برای: رفتاری

  ،از عبارتند اجرا روش اساس برانواع پرسشنامه: 

 (.آنلاین هایفرم مانند) کنندمی تکمیل را پرسشنامه تنهایی به دهندگانپاسخ:  4دهیخودگزارش

 (.سوادکم های جمعیت برای مناسب) شودمی تکمیل پژوهشگر توسط: ایمصاحبه

 .آنلاین هایپلتفرم طریق از: دیجیتال

 

 

 

 

 

                                                           
1 Self-Administered 
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 : خلاصه به طور

 

 

 گیری اندازه ابزار عنوان به ها پرسشنامه مزایای

 :دارند تحقیقات در ای ویژه جایگاه فردشان، به منحصر های ویژگی دلیل به ها پرسشنامه

 مثلاً،  .کوتاه زمان در( نفر هزاران یا صدها) بزرگ های نمونه از داده آوری جمع امکان: پذیری مقیاس و کارایی

 .کند آوری جمع را نفر 4444 های داده روز چند در تواندمی آنلاین پرسشنامه یک

 .دهدمی افزایش را ها داده مقایسه قابلیت دهندگان، پاسخ همه برای یکسان سؤالات: سازی استاندارد

 از) متنوع موضوعات برای و( مدیریت سلامت، آموزش،) مختلف های حوزه در استفاده قابل: پذیری انعطاف

 (.روان سلامت تا مشتری رضایت

 .تندهس تر اقتصادی ها پرسشنامه ،(مشاهده یا عمیق های مصاحبه مانند) دیگر هایروش به نسبت: کم هزینه

( یونرگرس یا عاملی تحلیل مانند) پیچیده های تحلیل برای ها پرسشنامه های داده: پیشرفته آماری تحلیل

 .هستند مناسب

 

 کاربرد مثال ویژگی ها نوع پرسشنامه

 تحلیل آماری SF-36 دارمقیاس  ساختارمند، کمی

 تحلیل مضمون های عمیق مصاحبه پذیرانعطاف سؤالات باز،  کیفی

 های گسترده ظرسنجین JDI هزینهسریع، کم خود گزارش دهی

 مدرن  تحقیقات Google Forms دسترسی بالا، تحلیل سریع دیجیتال
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 ها پرسشنامه های محدودیت و معایب

 :شود به آن پرداخته باید که دارند هایی چالش ها پرسشنامه مزایا، وجود با

 دهی پاسخ بایاس: 

 های خپاس( اجتماعی مقبولیت به تمایل مانند) شناختیروان یا اجتماعی دلایل به است ممکن دهندگان پاسخ

 تحت آنلاین هاینظرسنجی در ها پاسخ %94-24 که داد نشان 2429 سال در ای مطالعه. بدهند غیرصادقانه

 .هستند بایاس این تأثیر

 فرهنگ و سواد به وابستگی: 

 رمنج تفاهم سوء به تواندمی پرسشنامه نامناسب طراحی ،(ایران مانند) فرهنگی چند یا سواد کم جوامع در

 .شود

 هاداده عمق در محدودیت: 

 .دهند ارائه عمیق اطلاعات کیفی، های مصاحبه اندازه به توانندنمی معمولاً کمی های پرسشنامه

 روایی و پایایی ارزیابی به نیاز: 

 منجر غلط های گیریتصمیم به که کند، تولید نادرست های داده است ممکن پرسشنامه ها، ارزیابی این بدون

 .شودمی

 دیجیتال هایچالش: 

 هاداده کیفیت توانندمی فنی مشکلات و( %44 از کمتر گاهی) پایین دهی پاسخ نرخ آنلاین، های پرسشنامه در

 .دهند کاهش را

 

 عملی و علمی تحقیقات در هاپرسشنامه جایگاه

 و علمی مختلف های حوزه در و دارند محوری جایگاه تحقیقات در هایشان، ویژگی دلیل به ها پرسشنامه

 :دارند کاربرد اجتماعی
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 علمی تحقیقات در 

 یافسردگ یا انگیزه نگرش، مانند انتزاعی مفاهیم سنجش برای ها پرسشنامه: روانشناسی و اجتماعی علوم

 2421 سال در مطالعه 4444 از بیش در افسردگی تشخیص برای 4بک پرسشنامه مثلاً،. شوندمی استفاده

 .است شده استفاده

 و کنندهمصرف رفتار تحلیل برای( SERVQUAL مانند) مشتری رضایت های پرسشنامه: بازاریابی و مدیریت

 .شوندمی استفاده خدمات بهبود

 کاربرد مزمن بیماران در زندگی کیفیت ارزیابی برای WHOQOL یا SF-36 مانند ابزارهایی: پزشکی علوم

 .دارند

 ککم آموزشی های سیاست بهبود به آموزاندانش رضایت یا معلمان عملکرد ارزیابی های پرسشنامه: آموزش

 .کنندمی

 عملی کاربردهای در 

 جهبود تخصیص برای( شهروندی رضایت سنجش مانند) عمومی نظرسنجی های پرسشنامه :گذاری سیاست

 ممحرو مناطق در منابع تر عادلانه توزیع به توانندمی معتبر های داده مثلاً،. شوندمی استفاده دولتی های

 .کنند کمک

 .کنندمی کمک ترک نرخ کاهش به شغلی رضایت های پرسشنامه: انسانی منابع مدیریت

 به روان، سلامت های برنامه در( افسردگی برای PHQ-9 مانند) غربالگری های پرسشنامه: عمومی بهداشت

 .دارند کلیدی نقش درآمد، کم جوامع در ویژه

 مدرن و دیجیتال تحقیقات در: 

. اندکرده فراهم را ها داده بلادرنگ تحلیل امکان( Qualtrics مانند) دیجیتال های پرسشنامه فناوری، رشد با

 ند،کنمی استفاده آنلاین های پرسشنامه از المللیبین تحقیقات %75 که داد نشان 2425 سال در مطالعه یک

 .دارد وجود همچنان( کاغذی نسخه با سازگاری مانند) دیجیتال روایی ارزیابی به نیاز اما

                                                           
1 BDI 
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 روایی

 روایی تعریف

 به. است سنجد،می  کندمی  ادعا که آنچه سنجش در گیری اندازه ابزار یک صحت و دقت معنای به 4روایی

 روایی ، 2کرسول طبق. دیگری چیز نه کند، یریاندازه گ را موردنظر سازه دقیقاً باید روا ابزار یک دیگر، عبارت

 حاصل های تفسیر به توان می آیا و دارد همخوانی سازه نظری تعریف با پرسشنامه نتایج آیا که دهد می نشان

 هک دهد می پاسخ پرسش این به بلکه دارد، اشاره پژوهش هدف با تطابق به تنها نه روایی .کرد اعتماد آن از

 . سنجد می سیستماتیک خطای یا بایاس بدون را نظر مورد خصیصه حد چه تا ابزار

                مدل طبق. شود می دیده بعدی چند مفهوم یک عنوان به روایی مدرن، های استاندارد در

COSMIN   (Mokkink et al.,2018)، های جنبه شامل بلکه است، ساختاری و محتوایی تنها نه روایی 

 سازمانی هدتع "ارزیابی برای ایپرسشنامه اگر مثلاً،. ابزارها سازی بومی در ویژه به شود، می نیز زبانی و فرهنگی

 ،کنندمی گیری اندازه را "شغلی رضایت" که هستند ای گونه به هایش پرسش اما شده طراحی "کارکنان

 وعموض های جنبه همه که ای پرسشنامه همچنین،. باشد داشته بالایی آماری پایایی اگر حتی – ندارد روایی

 .ندارد مطلوبی روایی، نگیرد دربر را پژوهش مورد

 پرسش باراعت تا کنند استنباط پرسش از یکسانی مفهوم باید پژوهشگر و گو پاسخ: است کلیدی نکته این

 .شود حفظ

 

   روایی اهمیت

 گمراه های داده است ممکن روایی بدون ابزار زیرا است، ابزار یک عملی و علمی اعتبار اصلی هسته روایی

 :زا عبارتند روایی اهمیت کلیدی دلایل. شود می منجر غلط های گیری تصمیم به که کند تولید کننده

 .سنجدمی را درست سازه پرسشنامه که دهدمی اطمینان روایی :مفهومی دقت تضمین -

 .دان ضروری ها بیمارستان یا ها دانشگاه در غربالگری های برنامه برایروا  ابزارهای ایران، در :عملی کاربرد -

 ژورنال در انتشار برای تواندنمی روایی بدون ابزار ،COSMIN های استاندارد طبق :پژوهش علمی اعتبار - 

 .است روایی ضعف دلیل به مقالات رد %95 حدود – شود استفاده( ISI مثل) معتبر های

                                                           
1 Accuracy 
2 Creswell, 2020 
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 ای زبانی بایاس زیرا دارد، اهمیت ایران مانند فرهنگی چند جوامع در ویژه به روایی :فرهنگی سازیبومی -

 ازهاند ابزار روایی بهبود برای خوبی کمک خبرگان و کارشناسان نظر. دهد کاهش را دقت تواند می فرهنگی

 .است گیری

 اشتباه غربالگری مثل) نادرست هایتشخیص به توانندمی روایی بدون ابزارهای :خطاها و هاهزینه کاهش -

 .دهدمی افزایش %24 تا را درمانی هایهزینه که شوند، منجر( اضطراب

 

 روایی انواع

 وانر های استاندارد اساس بر انواع این شوند.می  تعریف یریه گانداز ابزار برای روایی از متفاوتی های گونه

 :از عبارتند روایی اصلی انواع. اند یافته گسترش( APA, 2017 مانند) سنجی

 1صوری روایی. 1

 سازه اب مرتبط کارشناسان و دهندگان پاسخ نظر به پرسشنامه سؤالات آیا اینکه ظاهری بررسی :تعریف -   

 .  خیر یا آیند می

  .ابزار پذیرش و بودن فهم قابل از اطمینان برای :کاربرد -   

 .دهنده پاسخ یا کارشناس 44-5 از کیفی نظرسنجی :ارزیابی -   

 2محتوایی روایی. 2

 .  خیر یا دهند می پوشش را سازه دامنه کل پرسشنامه سؤالات آیا اینکه بررسی :تعریف -   

 .ابزار بودن جامع از اطمینان برای :کاربرد -   

 (.CVR) محتوا روایی نسبت و( CVI) محتوا روایی شاخص :شاخص -   

 حتوایم روایی. شود می استفاده گیری اندازه ابزار یک دهنده تشکیل اجزای بررسی برای روایی از گونه این   

 های مهارت و ها ویژگی بیانگر ها پرسش اگر. دارد بستگی آن دهنده تشکیل های پرسش به پرسشنامه یک

  هم  محتوا روایی. دارد روایی محتوا دید از ابزار دارد، را ها آن گیری اندازه قصد پژوهشگر که باشند ای ویژه

                                                           
1 Face Validity 
2 Content Validity 
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  1سازه روایی. 3

 .  دارد همخوانی نظری چارچوب با و سنجد می را نظری سازه واقعاً ابزار آیا اینکه بررسی :تعریف -   

 .  کند متمایز افسردگی از را اضطراب باید که سنجی، روان ابزارهای برای :کاربرد -   

 ارد،د نظری مبنای که را ویژگی یا ساختار اندازه چه تا گیری اندازه ابزار که کندمی بیان روایی از نوع این   

 و شوند می تدوین شده گیری اندازه های مفهوم درباره هایی فرضیه ساختار، روایی بررسی در. سنجد می

 یروای بررسی برای که هایی شیوه از. شود می محاسبه اولیه های گیری اندازه و ها یافته میان همبستگی

 ظرین دیدگاه از که ها پرسش از گروه دو های پاسخ میان همبستگی بررسی به توانمی روند،می کاربه ساختار

 های پاسخ نظری لحاظ به که گویان پاسخ از هایی گروه مقایسه و باشند، داشته هم با زیادی ارتباط باید

 افزایش با شهری مناطق در رود می انتظار نمونه، عنوانبه. کرد اشاره دهند، می ارائه ها پرسش به متفاوتی

 دازهان برای که ای پرسشنامه از حاصل های داده چنانچه یابد؛ افزایش سیگار مصرف شیوع تحصیلات، سطح

  تحصیلات سطح با کنندگان مصرف های گروه میان را معناداری تفاوت شده، طرح سیگار مصرف گیری

 .  بود خواهد ساختار روایی دارای پرسشنامه این دهد، نشان متفاوت

 . 1است 9واگرا روایی و 2همگرا روایی زیرانواع شامل ساختار روایی

  ابزارهای از ها گیری اندازه میان بالا همبستگی: همگرا روایی

  غیرمرتبط های سازه با پایین همبستگی: واگرا روایی

 

  5ملاکی روایی. 1

 (.  طلایی معیار) خارجی استاندارد معیار یک با ابزار همبستگی بررسی :تعریف -   

 .  معتبر ابزارهای با مقایسه در ابزار دقت تأیید برای :کاربرد -   

    

                                                           
1 Construct Validity 
2 Convergent Validity 
3 Divergent Validity 
4 Allen & Benn,1979 
5 Criterion Validity 
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 .  زمان همان در معیار با مقایسه : 4همزمانی       :فرعی انواع -

 .آینده نتایج بینیپیش : 2بینیپیش                         

 به طور خلاصه:

 شاخص تعریف نوع روایی

 ظر کارشناسانن ظاهر مرتبط با سازه صوری

 CVR/CVI سازه پوشش کامل محتوایی

 تحلیل عاملی همخوانی با نظریه سازه

 همبستگی پیرسون همبستگی با معیار ملاکی

 

 روایی محاسبه های روش

 یا SPSS، AMOS مثل هایی افزار نرم با ها روش این. هستند اجرا قابل زیر های روش روایی ارزیابی برای

 :شوند می انجام Excel حتی

   صوری روایی. 1

 (.  دانشجویان مثلاً) دهندگان پاسخ یا( شناسانروان مثلاً) کارشناس 44-5 از کیفی نظرسنجی :روش -   

  محتوایی روایی. 2

 :    CVR– محتوا روایی نسبتشاخص  -     

CVR =
𝑛𝑒  − (

𝑁
2

)

𝑁
2

 

                                                           
1 Concurrent 
2 Predictive 
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𝑛𝑒  :می دانند.  ضروری ی که آیتم راکارشناسان تعداد 

N :کارشناسان. کل 

 CVR> 0.6  :آستانه 

  : CVI – محتوا روایی شاخص -     

 . توسط نظر اساتید و کارشناسان هاآیتم بودن مرتبط امتیاز میانگین

 CVI > 0.8  :آستانه

  سازه روایی. 3

 .  CFA - تأییدی و EFA - اکتشافی عاملی تحلیل :روش -   

 ملاکی روایی. 4

 .  بالینی تشخیص یا استاندارد ابزار با همبستگی محاسبه :روش -   

  پایایی

 پایایی تعریف

 اقعو در. است مشابه شرایط در پرسشنامه مانند گیری اندازه ابزار یک نتایج 4سازگاری و ثبات معنای به پایایی

 های داده حد چه تا ها داده گردآوری ابزار یا شیوه که دکن می فراهم موضوع این مورد در اطلاعاتی پایایی،

 یجهنت و است ثبات با و درست حد چه تا ها داده گردآوری ابزار یا شیوه یا کند می استخراج را موثقی و دقیق

 فاصله یک در گیریه انداز ابزار اگر که ندک می بیان پایایی دیگر عبارت به. دهد می دست به را سازگاری های

 بقط . هستند هم به نزدیک حد چه تا ها یافته شود، داده افراد از یکسانی گروه به بار چندین کوتاه زمانی ی

 .است گیری اندازه در تصادفی خطای نبود میزان دهنده نشان پایایی ، 2کرسول

 صفر از ایاییپ ضریب تغییر ی دامنه .شود می استفاده پایایی ضریب نام به شاخصی از پایایی گیری اندازه برای

 کامل یپایای. است کامل پایایی معرف ،یک پایایی ضریب و پایابی عدم معرف ،صفر پایایی ضریب. است 4 تا

 .کرد شک ها یافته به باید چیز هر از قبل شدنه مشاهد صورت در و شود می دیده ندرت به

                                                           
1 Consistency 
2 Creswell, 2020 
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 پایایی اهمیت

 آماری های تحلیل و نیستند اعتماد قابل نتایج ثبات، بدون زیرا است، گیری اندازه ابزار هر اعتبار پایه، پایایی

 . شوندمی معنی بی( عاملی تحلیل یا رگرسیون مانند)

 :از عبارتند پایایی اهمیت کلیدی دلایل

 ایه پاسخ مثل تصادفی های خطا) نویز از ابزار که دهدمی نشان بالا پایایی: تصادفی خطای کاهش 

 .است مصون( غیرصادقانه

 کندمی فراهم را مختلف جوامع در نتایج مقایسه امکان پایا ابزار: تعمیم قابلیت افزایش 

 استانداردهای طبق: روایی نیاز پیش COSMIN،  شرط ثبات زیرا باشد، روا تواندنمی پایایی بدون ابزار 

 .است دقت برای لازم

 مقالات: علمی اعتبار ISI شوندمی رد معمولاً پایایی گزارش بدون ها نامهپایان و. 

 

 پایاییمحاسبه  روش های

       نای از گروهی. شوند می برده کار به مختلفی های شیوه ، گیریه انداز ابزار پایایی ضریب محاسبه برای

. پردازند می پایایی ارزیابی به تکرار بدون ای ویژه فنون با برخی و بوده گیریه انداز تکرار بر مبتنی ها روش

 :کرد اشاره زیر موارد به میتوان ها روش این جمله از

 

 1بازآزمون آزمون روش 

. شودمی تعریف یکسان شرایط تحت آزمودنی گروه یک در بار یک از بیش آزمون یک ارائه صورتبه روش این

 اصلهف در سپس و شودمی اجرا گویان پاسخ از گروه یک روی پرسشنامه ابتدا پایایی، ضریب محاسبه برای

 همبستگی ضریب. شودمی اجرا گویان پاسخ همان روی شرایط همان در دوباره( هفته 2 مثلاً) کوتاهی زمانی

 .است ابزار پایایی از ای اندازه اجرا، بار دو در شدهکسب های امتیاز میان

                                                           
1 Test-Retest Reliability 
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 .4.7< آستانه با ،ICC 4 یا پیرسون همبستگی ضریب: شاخص

 .ساده زمانی ثبات بررسی: مزایا

 (.تگیخس یا یادگیری مثلاً) ندارد وجود دوم های پاسخ بر گویی پاسخ اولین تجربه اثر بررسی امکان: معایب

 2ارزی هم آزمون روش  

 اوتمتف آزمون دو صورتبه و است تربیتی و روانی های گیری اندازه در پایایی ارزیابی برای متداول روش این

             از یکسانی گروه روی مناسب زمانی فاصله با یا زمان یک در دارند، یکدیگر با زیادی های شباهت که

 رفتهگ نظر در پایایی ضریب عنوانبه آزمون، دو های امتیاز میان همبستگی ضریب. شودمی اجرا گویان پاسخ

 .شودمی

 .4.7< آستانه با پیرسون، همبستگی ضریب: شاخص

 .معادل های ابزار در ثبات بررسی: مزایا

 .است بر زمان معادل نسخه دو تهیه: معایب

 3سازی)خردنیم(نصف پایایی روش 

          میان ای مقایسه و( زوج و فرد سؤالات معمولاً) شودمی تقسیم قسمت دو به پرسشنامه روش، این در

 امکان زمانی و مالی های محدودیت دلیل به که زمانی روش این. شودمی انجام بخش دو از حاصل های امتیاز

 :مراحل. شودمی پیشنهاد ندارد، وجود آزمون دوباره اجرای

 معروف دیگری؛ در زوج گروه، یک در فرد سؤالات: معمول روش) شودمی تقسیم قسمت دو به پرسشنامه. 4

 (.زوج-فرد پایایی به

 .شودمی محاسبه قسمت دو های امتیاز میان پیرسون همبستگی ضریب. 2

  :شودمی تعدیل براون-اسپیرمن رابطه با حاصل مقدار. 9

𝑟′ =
2𝑟

1 + 𝑟
 

                                                           
1 Intraclass Correlation Coefficient 
2 Equivalent Forms   or   Parallel Forms Reliability 
9 Split-Half Reliability 



26 
 

 {که در گام دوم محاسبه می شود. است نیمه دو بین پیرسون همبستگی همان ضریب r که}

 .تکرار به نیاز بدون: مزایا

 (.باشند نابرابر ها نیمه است ممکن) تقسیم نحوه به وابسته: معایب

 1ریچاردسون-کودر روش 

  (خیر / بله مثل) ایدوگزینه ها پاسخ وقتی ویژهبه ها، پرسش درونی همبستگی محاسبه برای روش این

 :دارد وجود اصلی فرمول دو. است مناسب هستند،

 .است سازی نصف روش در ممکن های نیم همه همبستگی میانگین : 2 24 ریچاردسون-کودر. 4

 : فرمول 

𝑟𝐾𝑅−20 =
𝑘

𝑘 − 1
×

∑ 𝑝𝑖𝑞𝑖
𝑘
𝑖=1

𝑠𝑇
2

 

𝑞𝑖، پرسش به مثبت پاسخ با گویان پاسخ نسبت: 𝑝𝑖  ها، پرسش تعداد: k که = 1 − 𝑝𝑖 :گویان پاسخ نسبت 

𝑠𝑇، پرسش به نفیم پاسخ با
 .ها امتیاز کل واریانس: 2

 لک واریانس و میانگین تنها و است یکسان ها پرسش دشواری سطح وقتی برای : 9 24 ریچاردسون-کودر. 2

 .است موجود

  :فرمول

𝑟𝐾𝑅−21 =
𝑘

𝑘 − 1
× [ 

𝑋̅(1 − 𝑋̅)

𝑘 𝑠𝑇
2

 ] 

𝑠𝑇 ، ها پرسش تعداد: k که
 : میانگین کل امتیاز ها.𝑋̅  ،واریانس: 2

 .باینری سؤالات برای مناسب: مزایا

 .ای دوگزینه های پاسخ به محدود: معایب

                                                           
1 Kuder-Richardson Formulas 
2 KR-20 
3 KR-21 
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 1 کرونباخ آلفای روش 

 رایب که را مفهومی حد چه تا ابزار کندمی بیان که است گیریاندازه ابزار کلیدی های ویژگی از یکی روایی

 به زیادی حد تا که است معیاری پرسشنامه پایایی. کندمی گیری اندازه درستیبه شده، طراحی آن سنجش

 نیز عتمادا قابل و پایا اینکه مگر باشد( معتبر) روا تواندنمی ابزار یک دیگر، عبارت به است؛ وابسته آن روایی

 در آماره این از استفاده. آیدمی دستبه کرونباخ آلفای ضریب از استفاده با پایایی عینی گیری اندازه. باشد

 نیازمند که ارزی هم آزمون یا بازآزمون آزمون های برآورد مانند – پایایی سنجش های معیار سایر با مقایسه

 .است کارآمدتر و تر ساده مراتب به – هستند گیری اندازه تکرار

 یا پرسشنامه آزمون، یک های پرسش 2درونی سازگاری از ایاندازه عنوانبه را آلفا آماره( 4954) کرونباخ

 یک9 واقعی امتیاز واریانس نسبت صورت به آلفا ضریب حقیقت، در. است کرده معرفی گیری اندازه مقیاس

 تعریف گویان پاسخ همه میان در ها پرسش همه 1شده مشاهده امتیاز واریانس به ها پرسش از مجموعه

 اظلح به بنابراین،. است گیریاندازه خطای میزان و واقعی امتیاز از ترکیبی شده مشاهده واریانس. شودمی

 که کندمی بیان معیار این. کندمی اختیار( کامل سازگاری) 4 و( سازگاری عدم) 4 بین مقداری آلفا نظری،

 ضریب واقع، در. سنجند می را یکسانی مفهوم یا ساختار اندازه چه تا پرسشنامه یک در موجود های پرسش

 اصلی اجرای از پیش آن محاسبه و پرسشنامه، یک در ها پرسش درونی همبستگی بیان برای است معیاری آلفا

 .است ضروری پایایی از اطمینان برای پرسشنامه

  :شودمی ارائه کرونباخ آلفای ضریب برای معمول محاسباتی روابط از برخی ادامه، در

 .شودمی تعریف زیر صورتبه رود،می کاربه آلفا محاسبه برای که رابطه نخستین

α =
𝑘

𝑘 − 1
× ( 1 −

∑ 𝑠𝑖
2𝑘

𝑖=1

 𝑠𝑇
2

) 

 :  آن در که

k: (.  پرسشنامه) اطلاعات گردآوری ابزار های پرسش تعداد 

∑ 𝑠𝑖
2𝑘

𝑖=1  :پرسش هر امتیاز شده مشاهده های واریانس مجموع i جاری نمونه میان در  . 

                                                           
1 Cronbach’s Alpha 
2 Internal Consistency 
3 VarianceTrue 
4 Observed Variance 
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𝑠𝑇
 .  گویان پاسخ همه میان در پرسشنامه کل از شده کسب امتیازهای کل واریانس:  2

 های پاسخ از استفاده با و شودمی محاسبه تنهایی به پرسش هر واریانس و کل واریانس اساس بر فرمول این

 .آیدمی دست به جاری نمونه در گویان پاسخ همه

 محاسبه زیر رابطه با توان می را آلفا است، موجود ها پرسش 4کوواریانس-واریانس ماتریس که هایی حالت در

 :  کرد

α =
𝑘𝐶̅

𝑉̅ + (𝑘 − 1)𝐶̅
 

 :  آن در که

k :ها پرسش تعداد  . 

𝑉̅ :ها پرسش همه از شده کسب امتیازهای های واریانس میانگین  . 

𝐶̅ :واریانس ماتریس از) پرسشنامه های پرسش از شده کسب امتیازهای بین های کوواریانس میانگین-

 (.  است دسترسی قابل راحتیبه کوواریانس

 به شود، می شناخته 2استانداردشده کرونباخ آلفای نام با که آلفا، ضریب محاسباتی رابطه از دیگری صورت

 9گیهمبست ضریب ماتریس که شودمی پیشنهاد زمانی آلفا ضریب از شکل این از استفاده. است زیر صورت

  : باشد شده محاسبه ها پرسش به شده ارائه های پاسخ میان

α𝑠𝑡𝑑. =
𝑘𝑟̅

1 + (𝑘 − 1)𝑟̅
 

 :  آن در که

K :ها پرسش تعداد  . 

𝑟̅  :اصرعن میانگین صورت به) پرسشنامه های پرسش همه میان پیرسون های همبستگی ضریب میانگین 

 (.  شودمی تعریف همبستگی ضریب ماتریس پایینی و بالایی مثلث غیرتکراری

                                                           
1 Variance-Covariance Matrix 
2 Standardized Cronbach’s Alpha 
3 Correlation Matrix 
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 ها پرسش همه که زمانی. کندمی عمل ها پرسش همه درونی همبستگی میانگین عنوانبه  𝑟̅ حقیقت، در

 نتیجه در و یابدمی افزایش هاآن درونی همبستگی باشند، شده طراحی واحد مفهوم یک گیری اندازه برای

 از جموعهم یک که کندمی تعیین غیرمستقیم طور به آلفا بنابراین،. شودمی تر بزرگ نیز آلفا ضریب مقدار

 .کنند می گیری اندازه را یکسانی مفهوم یا ساختار اندازه چه تا ها پرسش

 

 هامحدودیت و آلفا ضریب بر مؤثر عوامل

 :  است عوامل این به توجه نیازمند آن تفسیر و است وابسته مختلفی عوامل به آلفا ضریب

  :ها پرسش تعداد -

 ن،بنابرای. باشد ضعیف درونی همبستگی اگر حتی دهد، می افزایش را آلفا معمولاً( k) ها پرسش بیشتر تعداد

 .  گرفت نظر در را ها آیتم تعداد باید نیست؛ بالا درونی همبستگی بیانگر همیشه آلفا بزرگ مقدار

  :درونی همبستگی -

   .بود اهدخو بالاتر آلفا و بیشتر درونی همبستگی باشند، شده طراحی مفهوم یک سنجش برای ها پرسش اگر

  :نمونه به وابستگی -

 ایداریپ عدم این. کندمی تغییر دیگر نمونه به ای نمونه از آن مقدار و است حساس بررسی مورد نمونه به آلفا

 .  رودمی شمار به آن منفی ویژگی یک 4گمشده مقادیر به نسبت

 بهمحاس اند، شده طراحی هدف یک از بیش بررسی برای که هایی پرسشنامه در :بعدی چند های رسشنامهپ -

 به شده، تهیه هدف همان درباره اطلاعات گردآوری برای که 2ها پرسش از زیرمجموعه هر برای آلفا ضریب

 .  است ضروری جداگانه صورت

 داده ایه پاسخ اطمینان قابلیت و درونی سازگاری از معیاری عنوان به موارد بیشتر در کرونباخ آلفای ضریب

 آلفا بضری برای را متفاوتی مقدارهای گوناگون نویسندگان. رودمی کاربه پرسشنامه یک های پرسش به شده

 و کرده بندی گروه را آلفا ضریب برای ممکن مقدارهای( 2449) مالری و جورج. اندگرفته نظر در مطلوب

 :اند داده ارائه گیرد،می قرار آن در استانداردشده آلفای مقدار که ای دامنه به توجه با را زیر های تفسیر

                                                           
1 Missing Values 
2 Subscale 
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 * 1استانداردشده کرونباخ آلفای مقدار تفسیر جدول*

𝛂𝒔𝒕𝒅. > 𝟎.  است عالی پرسشنامه پایایی 𝟗

𝛂𝒔𝒕𝒅. > 𝟎.  است خوب پرسشنامه پایایی 𝟖

𝛂𝒔𝒕𝒅. > 𝟎.  است قبول قابل پرسشنامه پایایی 𝟕

𝛂𝒔𝒕𝒅. > 𝟎.  است برانگیزپرسش پرسشنامه پایایی 𝟔

𝛂𝒔𝒕𝒅. > 𝟎.  است ضعیف پرسشنامه پایایی 𝟓

 

 مقدار از و است، 4.9 از تر بزرگ مقداری بالینی های کاربرد برای مطلوب آلفای ضریب مقدار این، بر علاوه

 .2شودمی یاد آل ایده شرایط عنوان با 4.95 از بیشتر

 ابزار که است این بیانگر 4.95 و 4.7 بین کرونباخ آلفای مقدار که گرفت نتیجه توان می کلی، حالت در

 .است کرده گردآوری را اطلاعات مناسبی پایایی با( پرسشنامه) گیریاندازه

 

 بهبود راهکارهای و آلفا ضریب کاهش دلایل

 هارسشپ میان ضعیف درونی همبستگی ها، پرسش تعداد بودن کم از ناشی تواندمی آلفا ضریب کوچک مقدار

 دارمق کاهش سبب ها پرسش میان ضعیف همبستگی چنانچه. باشد گیری اندازه ابزار 9بودن بعدی یک عدم یا

 بخش و بیشتر بررسی با توانمی علاوه،به. است مناسبی روش ها پرسش برخی گذاشتن کنار باشد، شده آلفا

 .  داد قرار گروه یک در دارند، یکدیگر با بیشتری درونی همبستگی که را هایی پرسش پرسشنامه، بندی

 تنهایی به ها پرسش تغییرپذیری و واریانس محاسبه پایایی، ارزیابی و آلفا ضریب محاسبه برای گام نخستین

 برای راه ترین ساده اطلاعات، این از استفاده با. است پرسشنامه به شده داده های پاسخ مجموعه واریانس و

 و ها پاسخ مجموعه در پرسش هر امتیاز میان همبستگی ضریب محاسبه حذف، نامزد های پرسش یافتن

                                                           
1 George & Mallery, 2003 
2 Bland & Altman, 4997 
3 Uni-Dimensionality 
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 ستا بهتر همچنین،. شوندمی حذف صفر به نزدیک همبستگی با هایی پرسش. است پرسشنامه کل امتیاز

 در و شده جدا پرسشنامه کل مجموعه از دارند، ها پرسش دیگر با منفی همبستگی ضریب که هایی پرسش

 رسشنامهپ پایایی میزان نتیجه در و آلفا ضریب مقدار ترتیب، این به. گیرند قرار پرسشنامه از دیگری بخش

 .   4یابدمی افزایش

          انجام خودکار صورت به را کار این "Scale if Item Deleted" تحلیل ،SPSS مانند افزارهایینرم در

 .بخشدمی بهبود را آلفا آیتم کدام حذف دهد می نشان و دهد می

 

 نادرست تفسیر مورد در هشدار

 به و تخابان به منجر تواندمی آلفا ضریب نادرست تفسیر و استفاده که است ضروری نکته این بیان انتها، در

 که ییها پیشنهاد رعایت. دهد می نتیجه را اعتمادی غیرقابل های یافته که شود نامناسب ابزار یک کارگیری

 هب توجه همچنین و( بودن مرتبط و وضوح مانند) شده بیان ها پرسش تک تک انتخاب و طراحی خصوص در

  رمنج – اطلاعات گردآوری ابزار ترین متداول عنوانبه – پرسشنامه طراحی چگونگی درباره شده ارائه نکات

 . شد خواهد پژوهش اهداف بر مبتنی استاندارد پرسشنامه یک طراحی به

 

 پایایی و روایی میان ارتباط

 پایایی و روایی ارتباط مفهوم

 یحال در دارد، اشاره موردنظر سازه سنجش در گیری اندازه ابزار یک دقت به رواییطبق تعاریف گفته شده، 

 اما اند، وابسته هم به مفهوم دو این. است مربوط مشابه شرایط در ابزار نتایج سازگاری و ثبات به پایایی که

 ورتص به توان می را ها آن بین ارتباط. اند ضروری پرسشنامه یک اعتبار برای دو هر و یکدیگرند از مستقل

 :کرد خلاصه زیر

 

 

                                                           
1 Tavakol & Dennick, 2444 
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  :است روایی نیاز پیش پایایی -

  توان نمی باشد، تصادفی خطای از پر و ناپایدار ابزار نتایج اگر زیرا باشد، روا تواند نمی پایایی بدون ابزار 

 لازم شرط پایایی ،COSMIN های استاندارد طبق. سنجد می درستی به را موردنظر سازه که بود مطمئن

 .نیست کافی اما است، روایی برای

 :است ممکن روایی بدون پایایی اما نیست، ممکن پایایی بدون روایی -

 (. بسنجد را غلطی سازه) نباشد روا اما( بدهد ثابتی نتایج) باشد پایا تواندمی ابزاری 

 :متقابل تأثیر -

 بالا 4واییمحت روایی اگر برعکس،. شوند می تر دقیق نتایج زیرا کند، تقویت را روایی تواند می پایایی بهبود 

 . دارند( پایایی) بهتری درونی همسانی احتمالاً تر مرتبط سؤالات باشد،

 

 

 

 

 

 

 

 

 

 

 

                                                           
1 CVI 
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 پژوهش شناسی روش :فصل سوم
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 طرح پژوهش

ند و کها را مشخص می عنوان نقشه راه کلی مطالعه، ساختار اجرایی، تحلیل و تفسیر یافته طرح پژوهش به

 این پژوهش با هدف ارزیابی پایایی و روایی کند. نتایج ایفا می و خارجی نقش کلیدی در تضمین اعتبار داخلی

  شود. میدر یک نمونه از دانشجویان پزشکی مکزیکی انجام  GAD4- 7پرسشنامه

دانشجوی  777از یک مجموعه داده عمومی استخراج شده که شامل اطلاعات جامع از  ،های مورد استفاده داده

شود، بلکه  می GAD-7آوری شده و نه تنها شامل امتیازات  جمع 2441ها در سال  پزشکی است. این داده

گیرد. طرح پژوهش بر اساس  میمتغیرهای مرتبط با سلامت روان، خواب و عوامل دموگرافیک را نیز در بر 

های موجود برای بررسی ساختار  طراحی شده است، جایی که تمرکز اصلی بر تحلیل آماری داده 2رویکرد کمی

 های مرتبط است. درونی پرسشنامه، ثبات آن و همخوانی با سازه

ای جامع از جامعه مورد مطالعه فراهم آید.  شود تا زمینههای کلی مجموعه بررسی می در این طرح، ابتدا داده

های دموگرافیک )مانند سن،  های متنوعی مانند ویژگی متغیر است که از جنبه 97مجموعه داده شامل 

(، GAD-7اضطراب )از طریق  (، علائمPHQ-9جنسیت، قد و وزن(، علائم افسردگی )از طریق پرسشنامه 

( و عوامل تحصیلی )مانند ساعات مطالعه هفتگی و معدل تحصیلی(  ESS9کیفیت خواب )از طریق مقیاس 

کند، اما تمرکز تخصصی  میبعدی را فراهم  های چند تشکیل شده است. این تنوع متغیرها امکان تحلیل

            ( gad7 تا  gad1شده )ی امتیازدهاست که شامل هفت آیتم  GAD-7های مرتبط با  پژوهش بر داده

 24تا  4ها از آنکنند و امتیاز کل  میها علائم اضطراب عمومی را در دو هفته اخیر ارزیابی  شود. این آیتمی م

 متغیر است.

انند مطالعات و کاربرد گسترده در غربالگری اضطراب )م دلیل سادگی، حساسیت بالا به GAD-7انتخاب 

Household Pulse Surveyدهد. نشان می های بزرگ ( است، که شیوع اضطراب را در جمعیت 

و تحلیل  GAD-7سنجی  های روان است، که بر توصیف ویژگی و مقطعی تحلیلی – نوع پژوهش توصیفی

شامل آزمون فرضیات تمرکز دارد. جنبه توصیفی شامل بررسی آمارهای پایه و جنبه تحلیلی  روابط آماری

 و استنباطی. این طرح بر مدل با تأکید بر آمار توصیفی سنجی است. رویکرد پژوهش کمی غالب است،  روان

 1COSMIN  دهی است و برای  تکیه دارد، که شامل مراحل ارزیابی محتوا، سازه، ملاکی و قابلیت پاسخ

                                                           
1 Generalized Anxiety Disorder-7 
2 quantitative 
3 Epworth Sleepiness Scale 
4 Consensus-based Standards for the selection of health Measurement INstruments 



35 
 

          استفاده شده، 4های ثانویه ن، از رویکرد دادهآل است. همچنی ایده GAD-7گزارشی مانند  ابزارهای خود

 از   Mental health data of Mexican medical studentsکه شامل استخراج و تحلیل دیتاست 

figshare  .است 

 دلیل انتخاب طرح

  های بزرگ دارد.  سنجی در داده نیاز به ارزیابی روان GAD-7اضطراب عمومی یک مسئله جهانی است و 

)مانند ثبات زمانی در دیتاست  GAD-7های  ویژگی  دهد تا بدون مداخله، می تحلیلی اجازه  – طرح توصیفی

HPSهای ایرانی تعمیم داد توان به زمینه ( تحلیل شود، در حالی که نتایج را می . 

 

 ، نمونه و روش نمونه گیریجامعه آماری

پذیری و اعتبار خارجی پژوهش را  مجموعه کامل عناصر مورد مطالعه، پایه تعمیمعنوان  جامعه آماری به

 دانشجویانگیری نقش محوری دارد. در این پژوهش، جامعه آماری شامل  دهد و در طراحی نمونه تشکیل می

 این. استبوده  نفر 1524 هاآن  کل تعداد 2441 سال در که است مکزیک در خصوصی دانشگاه یک پزشکی

 دانشجویان زیرا شده، انتخاب توسعه حال در کشورهای در پزشکی دانشجویان از ای نماینده عنوانبه  جامعه

 زیابیار برای مناسبی زمینه تواندمی که هستند روبرو اضطراب و استرس از بالایی سطوح با اغلب پزشکی

 تحصیلی و جنسیتی سنی، تنوع از آماری جامعه. کند فراهم GAD-7 مانند اضطراب غربالگری ابزارهای

 .شود می چهارم تا اول های سال دانشجویان شامل و است برخوردار

 در. اند شده انتخاب 2ساده تصادفی گیرینمونه روش طریق از که است دانشجو 777 شامل پژوهش نمونه

 انتخاب نفری 1524 جامعه کل از تصادفی صورت به دانشجو 4244 ابتدا اصلی، های داده آوری جمع فرآیند

 اساس بر نمونه حجم این. کردند شرکت مطالعه در( %71.7 دهی پاسخ نرخ با) نفر 777 سپس و شدند

 ی،عامل تحلیل و داخلی پایایی محاسبه برای زیرا است، کافی روانسنجی های تحلیل برای آماری معیارهای

 برای نفر 74 تا 95 حداقل یعنی) پرسشنامه های آیتم تعداد برابر 44 تا 5 پیشنهادی نمونه حجم حداقل

GAD-7 )،دهدمی  کاهش را گیرینمونه خطای و کندمی  فراهم بالایی آماری قدرت نفر 777 حجم اما است. 

 ستا ممکن هرچند است، نمونه بودن نماینده و اسبای عدم کنندهتضمین  ساده تصادفی گیرینمونه  روش

 نمایی بیش احتمال مانند) شود ها محدودیت برخی به منجر %444 از تر پایین دهی پاسخ نرخ مانند عواملی

                                                           

1 secondary data 
2 simple random sampling 
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 خام امتیازات شامل نمونه ،GAD-7 های داده بر تخصصی تمرکز در(. روان سلامت به مند علاقه دانشجویان

 اخلید پایایی و عاملی ساختار بررسی برای تواندمی  هاآن  توزیع که است کنندهشرکت  هر برای آیتم هفت

 و روایی های تحلیل برای نمونه کل و نشده اعمال پژوهش این در اضافی گیریزیرنمونه هیچ. شود استفاده

 یهمخوان سنجی روان های پژوهش شناسی روش های استاندارد با رویکرد این. شود می گرفته کار به پایایی

 می دهد. افزایش را پزشکی دانشجویان مشابه جوامع به نتایج پذیری تعمیم امکان و دارد

 های جامعه ویژگی

 نفر 1524:  حجم جامعه 

 است پزشکی دانشجویان جوان جمعیت دهنده نشان که سال، 25 تا 48 بین عمدتاً: سنی محدوده. 

 زن و مرد جنس دو هر شامل: جنسیت 

 هک تحصیل، چهارم سال تا اول سال از پزشکی، کارشناسی مقطع در دانشجویان: تحصیلی وضعیت 

 .است بالینی و آموزشی های تجربه در تنوع دهنده نشان

 اقتصادی های ویژگی است ممکن که مکزیک، در خصوصی دانشگاه یک به محدود: جغرافیایی محل-

 .کند منعکس را( بهتر آموزشی منابع به دسترسی مانند) خاصی اجتماعی

 از است، روان سلامت از متفاوتی سطوح با افرادی شامل احتمالاً جامعه: اجتماعی و روانی شرایط 

 .پزشکی حرفه خاص فشارهای دلیل به دارند، افسردگی یا اضطراب علائم که کسانی جمله

 که ند،هست مکزیکی فرهنگ تأثیر تحت و کنندمی زندگی اسپانیایی زبان به جامعه: زبان و فرهنگ 

 .بگذارد اثر ها پرسشنامه به دهی پاسخ بر تواند می

 تمرکز مانند هایی محدودیت اما است، برخوردار نسبی تنوع از آماری جامعه که دهند می نشان هاویژگی این

 .ذاردبگ تأثیر نتایج پذیری تعمیم بر است ممکن گسترده جغرافیایی تنوع عدم و خاص دانشگاه یک بر

 های نمونه ویژگی

 رنف 777: نمونه حجم -

 سال 22-24 تقریبی سنی میانگین با سال، 25 تا 48 بین :سنی محدوده -

 مردان  % 54/18زنان و  % 54/54  ،جنس زن و مرد دو هر شامل: جنسیت -
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 -نفر، سال سوم 484 -نفر، سال دوم 279 -)سال اول چهارم تا اول های سال بین در توزیع: تحصیلی سال -

 نفر( 475 -نفر، سال چهارم 414

 نشان که است، 24 تا GAD-7   4 امتیازات از وسیعی طیف با افرادی شامل نمونه: روان سلامت وضعیت -

 است ESS و PHQ-9 های داده شامل همچنین. است اضطراب شدید و متوسط خفیف، حداقل، وجود دهنده

 .است خواب مشکلات و افسردگی با پوشانی هم دهنده نشان که

 مثلاً) جانبی هایتحلیل  برای تواندمی  که( کیلوگرم به) وزن و( متر به) قد شامل: فیزیکی های ویژگی -

 (77/77، میانگین وزن: 79/4: )میانگین قد .شود استفاده( استرس با ارتباط

 در  تنوع دهنده نشان 2هفتگی مطالعه ساعات و 4شبانه خواب ساعات میانگین: تحصیلی و خواب عادات -

 .بگذارد اثر اضطراب بر است ممکن که است زندگی سبک

 هب دهی پاسخ با مکزیکی دانشجویان نماینده اما دانشگاه، یک به محدود: فرهنگی و جغرافیایی توزیع -

 .اسپانیایی زبان به پرسشنامه

 %7/71 دهی پاسخ نرخ هرچند است، جامعه به نسبت نسبی بودن نماینده دهنده نشان نمونه های ویژگی

 رکتش بیشتر مندند علاقه روان سلامت به که افرادی مثلاً) باشد انتخابی بایاس وجود معنای به است ممکن

 این. دهد می افزایش را ها تحلیل اطمینان قابلیت نمونه، حجم و متغیرها در تنوع حال، این با(. اند کرده

 توزیع اساس بر را روایی و پایایی بررسی امکان زیرا هستند، مهم GAD-7 های داده برای ویژهبه ها ویژگی

 .کنندمی  فراهم امتیازات واقعی

 

 پرسشنامه توصیف و معرفی

است که توسط  1یک ابزار غربالگری کوتاه و معتبر برای ارزیابی اختلال اضطراب عمومی GAD9-7پرسشنامه 

Spitzer  توسعه یافته است.  2447و همکاران در سال 

 

                                                           
1 reported_sleep_hours 
2 weekly_study_hours 
3 Generalized Anxiety Disorder 7-item 
4 Generalized Anxiety Disorder 
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 گذشته هفته دو در عمومی اضطراب علائم شدت سنجش: موضوع 

 سؤال 7: سؤالات تعداد  

 (.روز هر تقریباً = 9 روزها، نصف از بیش = 2 روز، چند = 4 اصلاً، = 4) ایدرجه 1 لیکرت: مقیاس 

 (اضطراب بدون) 1-4. تفسیر: (24-4 محدوده) سؤال 7 امتیازات جمع :کل گذارینمره                    ،

 .(شدید) 24-45  ،(متوسط) 41-44، (خفیف) 5-9

 (. دانشجویان اضطراب مثل) آموزش حتی و عمومی بهداشت روانشناسی، برای مناسب: کاربرد 

)برای  ESS)برای افسردگی( و  PHQ-9تری است که شامل  این پرسشنامه بخشی از مجموعه داده بزرگ

تا پایایی داخلی و ساختار عاملی آن در  ،است GAD-7شود، اما تمرکز این پژوهش بر  میآلودگی(  خواب

 .نمونه دانشجویان پزشکی مکزیکی بررسی شود

 عمومی اضطراب شدت سنجش انتخاب علت

 زندگی کیفیت بر توجهی قابل تأثیرات تواندمی که است روانی اختلالات ترین شایع از یکی عمومی اضطراب

 ارهایفش میزان معاصر، دنیای در محیطی و اقتصادی اجتماعی،  سریع تغییرات به توجه با. باشد داشته فرد

 ایه بیماری شیوع پی در و اخیر سال دو در ویژه به موضوع این. است یافته افزایش افراد در اضطراب و روانی

به همین علت از نظر بنده این موضوع  .خوردمی  چشم به بیشتر اقتصادی، و اجتماعی های بحران و جهانی

 پتانسیل بالایی برای انجام پژوهش و بررسی داشت.

 عمومی اضطراب سنجش اهمیت

 اختلال این هنگام زود شناسایی به تواندمی  عمومی اضطراب علائم شدت سنجش: هنگام زود تشخیص. 4

 .نماید تشویق مناسب درمان دریافت به را افراد و کند کمک

 دست خود زندگی کیفیت بهبود به توانندمی  افراد اضطراب، مدیریت و شناسایی با: زندگی کیفیت بهبود. 2

 .شوند مندبهره  زندگی مختلف های زمینه در بهتری عملکرد از و یابند

 کمک عمومی اضطراب عواقب و علائم درباره عمومی آگاهی افزایش به تواندمی  پژوهش این: بخشی آگاهی. 9

 .دهد سوق اختلال این درمان و پذیرش سمت به را افراد و کند

          ات کند کمک روان سلامت متخصصان و محققان به تواندمی  پرسشنامه این نتایج: توسعه و تحقیق. 1

 .دهند توسعه عمومی اضطراب مدیریت و درمان برای بهتری های روش
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 هترب خود روانی های چالش با تا کندمی کمک فرد به تنها نه عمومی اضطراب علائم شدت سنجش نهایت، در

 به عموضو این. کند کمک اختلال این از ناشی روانی بار کاهش در نیز جامعه به تواندمی  بلکه کند، مقابله

 .است زمینه این در بیشتر های پژوهش انجام ضرورت و اهمیت دهنده نشان وضوح

 

 پرسشنامه

 7 فراگیر اضطراب اختلال  -  Generalized Anxiety Disorder 7 (GAD-7):  عنوان

 :منبع پرسشنامه

گیری شدت آن است. این ابزاری کوتاه برای غربالگری اختلال اضطراب عمومی و اندازه GAD-7پرسشنامه 

                       Robert L. Spitzer ،Kurt Kroenke ،Janet B.W. Williamsپرسشنامه توسط دکتران 

  .همکارانشان توسعه یافته استو 

 :منبع دیتاست

 figshareدانشجوی پزشکی مکزیکی در سایت  777های سلامت روان  داده
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 : ترجمه

 بیش) 2 ،(روز چند) 4 ،(اصلاً) 4 است؟ داده آزار را شما حد چه تا زیر مشکلات از یک هر گذشته، هفته دو در

 (روز هر تقریباً) 9 ،(روزها نصف از

 

 پژوهش این در روایی بررسی های روش

در سنجش  GAD-7گیری، دقت پرسشنامه  های کلیدی ارزیابی ابزارهای اندازهه جنبعنوان یکی از  روایی به

های ترکیبی کیفی و کمی بر اساس دیتاست  کند و در این پژوهش با روشسازه اضطراب عمومی را بررسی می

Mental health data of 776 Mexican medical students های روایی به  شود. روش اجرا می

ای ه با تمرکز بر ویژگی شوند: صوری، محتوایی، سازه و ملاکی، که هر کدام چهار دسته اصلی تقسیم می

 شوند تا روایی در گروه دانشجویان تأیید شود. اجرا می SPSSافزار  ( و نرمgad1دیتاست )مانند توزیع نمرات 

 روش بررسی روایی صوری

تمرکز دارد. در این پژوهش، روایی صوری  GAD-7های  بر ارزیابی ظاهری و قابل فهم بودن آیتماین روش  

 gad1شود، که هر آیتم ) شناسان بالینی( انجام می کارشناس سلامت روان )مانند روان 44با نظرسنجی از 

بسیار مرتبط و واضح(.  = 5نامرتبط و غیرقابل فهم،  =4دهند ) ای امتیاز می درجه 5( را بر مقیاس gad7تا 

 شود.  ( برای پذیرش تعیین می1<)میانگین  %84شود و آستانه توافق  محاسبه می میانگین امتیاز هر آیتم

 گذارینمره متن  انگلیسی متن  فارسی شماره

 Feeling nervous, anxious, or on edge 4-9 قراریاحساس عصبی بودن، اضطراب یا بی 1

 Not being able to stop or control worrying 4-9 کنترل نگرانیناتوانی در توقف یا  2

 Worrying too much about different things 4-9 نگرانی بیش از حد درباره چیزهای مختلف 3

 Trouble relaxing 4-9 مشکل در آرام شدن 4

 Being so restless that it is hard to sit still 4-9 قراری شدید که نشستن را دشوار کندبی 5

 Becoming easily annoyed or irritable 4-9 پذیر شدنبه راحتی عصبانی یا تحریک 6

احساس ترس، مثل اینکه ممکن است اتفاق  7

 بدی بیفتد

Feeling afraid, as if something awful might 
happen 

4-9 
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دهنده ابهام فرهنگی در گروه دانشجویان پزشکی )با استرس تحصیلی بالا(  نشان، اگر روایی صوری پایین باشد

  شود. سازی آیتم ارائه می است و پیشنهاد ساده

 به کارشناسان سلامت روان، روایی صوری انجام نمی شود.در این پژوهش، به دلیل محدودیت دسترسی 

  روش بررسی روایی محتوایی

د. شو قراری( استفاده می برای اطمینان از پوشش کامل دامنه اضطراب عمومی )مانند نگرانی و بیاین روش 

 شود. محاسبه می CVIو  CVRروایی محتوایی با دو شاخص  ،در این پژوهش

- CVR  :)غیرضروری"یا  "مفید"، "ضروری"عنوان متخصص هر سؤال رو به 44)نسبت روایی محتوا" 

متخصص تشخیص دهند  8باشد )حداقل  7/4باید بالای  CVRکنند. با فرمول لوشه، مشخص می

 ضروری است(.

 با فرمول : 

CVR =
𝑛𝑒  − (

𝑁
2

)

𝑁
2

 

- CVI  باشد. 8/4( باید بالای 1-4ها )مقیاس )شاخص روایی محتوا(: میانگین امتیاز مرتبط بودن سؤال 

ها( بین آیتم   < r 4.1شود تا پوشش محتوایی )( چک می gad1-gad7ها )، همبستگی بین سؤالSPSSدر 

( باید همبستگی "از حدنگرانی بیش ") gad3( و "ناتوانی در کنترل نگرانی") gad2تأیید شود. برای مثال، 

دهنده عدم پوشش کامل آن از باشد، نشان  7/4( زیر gad7یک سؤال )مثل  CVRقوی داشته باشند. اگر 

 اضطراب است. 

 هروش بررسی روایی ساز

شود. در این  پژوهش، بعدی( استفاده می با نظریه اضطراب )مدل تک  GAD-7این روش برای تأیید هم خوانی 

 .شودارزیابی می  CFAو  EFAروایی سازه با 

 تحلیل عاملی اکتشافی :(EFA) در SPSS  با روش Principal Component Analysis و چرخش 

Varimaxمی شوند به یک عامل )اضطراب( مربوط پرسشنامه، سؤال 7کنیم که آیا ، چک می . 
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  :هاشاخص

o  KMO د(رکور 777برای  4.8 ~)انتظار  4.7 بالای 

o 4.45ر با عناداآزمون بارتلت م p<  

o  (%74~)انتظار  %54واریانس توضیحی بالای 

o بار عاملی هر سؤال (gad1-gad7)  4.1بالای. EFA  

 تحلیل عاملی تأییدی :(CFA) در AMOSها به یک عامل اضطراب(  بعدی )همه سؤال ، مدل تک

 .ودش تست می

  :ها شاخص 

o CFI   فیت خوب 4.9بالای() 

o  RMSEA  جویی، برای صرفه) مک )خطای 4.48زیر CFA  اجرا  رکورد تصادفی 944روی

و واگرا )همبستگی   PHQ-9، 4.7~ ( r  . همچنین، روایی همگرا )همبستگی قوی باودشیم

 .ی شودچک م SPSS در  > Epworth،4.1 (r ضعیف با

 روش بررسی روایی ملاکی

شود. برای افسردگی همبود( استفاده می PHQ-9با معیارهای خارجی )مانند  GAD-7برای مقایسه این روش 

 :SPSS در

  همبستگی پیرسون بین نمره کل  :همزمانیروایی GAD-7 و  PHQ-9 (محاسبه )افسردگی           

  < r) 4.7(شود.  می

  بینی نمره برای پیش یرگرسیون خط : بینی پیشروایی GAD-7 بر اساس متغیرهایی مثل 

thoughts_of_dropping_out  یا  previous_depression 4.9(ود. شی اجرا م (R² > 

، چون اضطراب و افسردگی د( داشته باش4.7~همبستگی قوی ) PHQ-9 با GAD-7 انتظار داریم

 .دهمبودی دارن
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 های بررسی پایایی در این پژوهش روش

        دارد و نشانگیری اضطراب عمومی اشاره در اندازه GAD-7 به میزان ثبات و سازگاری پرسشنامه پایایی

دهد که آیا نتایج حاصل از این ابزار در شرایط مختلف تکرارپذیر و قابل اعتماد هستند یا خیر. در این ی م

و  سازینصف ارزی،  هم  بازآزمون،-آزمون ،آلفای کرونباخ های با استفاده از روش GAD-7 پژوهش، پایایی

شود. این  د از دانشجویان پزشکی مکزیکی ارزیابی میرکور 777بر روی دیتاست شامل  ریچاردسون-کودر

دهد،  ( ارائه می9تا  4ای )درجه 1، در مقیاس لیکرت gad7) تا gad1) GAD-7 آیتم 7دیتاست، که نمرات 

 های روان (، برای تحلیل%5های خام با مقادیر گمشده کم )کمتر از  مورد( و داده 777به دلیل حجم مناسب )

 های ها بر اساس استاندارد شوند، و روش انجام می SPSSافزار ها با نرم آل است. تحلیل سنجی ایده

COSMIN  اند. در ادامه، هر روش توضیح داده شده و کاربرد آن  های دیتاست مقطعی انتخاب شده و ویژگی

 .شود در این دیتاست بررسی می GAD-7 برای

 روش آلفای کرونباخ -

 سؤال پرسشنامه 7دهد که آیا  کند و نشان میرا بررسی می GAD-7 های ی آیتماین روش همسانی درون

شود  محاسبه می SPSS کنند. آلفای کرونباخ با استفاده ازگیری میصورت منسجم اضطراب عمومی را اندازهبه

 gad2 ها )مانند باشد تا پایایی قابل قبولی تأیید شود. در این روش، همبستگی بین آیتم 7/4 و باید بالاتر از

تأثیری  دهد که حذف هر آیتم چه  نشان می "Scale if Item Deleted" و گزینه شود ( بررسی میgad3 و

آلفای رود  ، انتظار میGAD-7 (Spitzer et al.,2006)نل دارد. با توجه به مطالعات پیشیبر آلفای ک

دهنده پایایی بالای پرسشنامه در میان دانشجویان  باشد، که نشان 9/4تا  85/4 کرونباخ در این دیتاست بین

 های با همبستگی ضعیف مانند باشد، آیتم 7/4است. اگر آلفا کمتر از  %25-94پزشکی با نرخ اضطراب تقریبی

(gad7) رت، های لیک دلیل سادگی و مناسب بودن برای مقیاسشوند. این روش به  برای اصلاح شناسایی می

 .رکورد کاملاً مناسب است 777برای دیتاست 

 یساز روش نصف -

و  gad7) تا gad5 و gad4 تا (gad1 ها به دو نیمه سازی پایایی پرسشنامه را با تقسیم آیتم روش نصف 

همبستگی پیرسون بین دو نیمه محاسبه شده ، ضریب SPSS کند. درها ارزیابی می بررسی همبستگی بین آن

 .شود تعدیل می Spearman-Brown و با فرمول

مناسب است، زیرا نیازی  د شود. این روش برای دیتاستباشد تا پایایی تأیی 7/4شده باید بالای ضریب تعدیل

 رود ضریب نصف ظار میدهد. انت رکورد، نتایج پایداری ارائه می 777های دو نوبت ندارد و با حجم  به داده
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ویژه برای تأیید پایایی در  است. این روش به GAD-7 دهنده ثبات درونی باشد، که نشان 8/4سازی حدود 

 .های پراسترس مانند دانشجویان پزشکی مفید است گروه

  بازآزمون -روش آزمون -

مقطعی  کند. از آنجا که دیتاستمیهای زمانی مختلف بررسی  را در بازه GAD-7 های این روش ثبات پاسخ

ود. شهای دیتاست اجرا می سازی بر اساس زیرگروه های طولی )دو نوبت( ندارد، این روش با شبیه است و داده

شود تا ثبات  مقایسه می) 8-5(یهای بعد با ترم) 1-4 (های ابتدایی های دانشجویان در ترم برای مثال، پاسخ

         محاسبه SPSSدر4با مدل دوطرفه مخلوط  (ICC)ایطبقه ضریب همبستگی درونتقریبی بررسی شود. 

باشد، ممکن  7/4باشد، اما اگر کمتر از  85/4-75/4حدود  ICC رود باشد. انتظار می 7/4شود و باید بالای  می

ن روش به دلیل های مختلف( باشد. ای است به دلیل تأثیر عوامل محیطی )مانند استرس امتحانات در ترم

امکان بررسی نسبی  semester های سازی با زیرگروه هایی دارد، اما شبیه مقطعی بودن دیتاست محدودیت

 .کند ی را فراهم میثبات زمان

  ارزی روش هم -

را با مقایسه آن با فرم موازی یا ابزار مشابه )مانند مقیاس اضطراب دیگر(  GAD-7 ارزی پایایی روش هم 

 GAD-7 ، این روش با مقایسه همبستگیGAD-7 کند. در این دیتاست، به دلیل نبود فرم موازیمیبررسی 

، همبستگی SPSS شود. درسازی میشبیه ،برای افسردگی، که همبودی بالایی با اضطراب دارد PHQ-9 با

 باشد، که نشان 7/4-7/4رود حدود  شود و انتظار می محاسبه می PHQ-9 و GAD-7 پیرسون بین نمره کل

شود و  صورت محدود اجرا می ارزی نسبی است. این روش به دلیل نبود فرم موازی مستقیم، به دهنده هم

 .شود بیشتر برای تأیید همبستگی با ابزارهای مرتبط استفاده می

 ریچاردسون-روش کودر -

از  GAD-7 مناسب است، اما( 4/4های دوگانه ) برای مقیاس(  KR-21 یا KR-20 ) ریچاردسون-روش کودر

برد کمتری دارد کار GAD-7 کند. این روش به دلیل ماهیت غیرباینریای استفاده می درجه 1مقیاس لیکرت 

 .شودمیبررسی ن و

 

های لیکرت و دیتاست مقطعی،  سازی به دلیل مناسب بودن برای مقیاس های آلفای کرونباخ و نصف روش

بازآزمون به دلیل  - اند. روش آزمون بسیار دقیقGAD-7 پژوهش هستند و برایهای این  ترین روشاصلی

                                                           
1 Two-Way Mixed 
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ارزی به دلیل نبود فرم  هایی دارد. روش هم شود و محدودیت سازی اجرا می مقطعی بودن دیتاست، با شبیه

 نریریچاردسون نیز به دلیل ماهیت غیربای-شود. روش کودر اعمال می PHQ-9 صورت محدود باموازی، به

GAD-7 ، پایایی، های دیتاست ها، با توجه به ویژگیشود. این ترکیب روشمین بررسی GAD-7 طور  را به

 .سنجی همخوانی دارد های روان کند و با استانداردجامع تأیید می

 

 هاهای تجزیه و تحلیل دادهروش

رکورد از دانشجویان پزشکی مکزیکی  777 شامل بر روی دیتاست  SPSS افزار ها با استفاده از نرم تحلیل داده

، age ،gender ) ، متغیرهای دموگرافیکgad7 تا gad1 هایشود. این دیتاست، که شامل ستون انجام می

school_year)و متغیرهای مرتبط )مانند ، phq1-phq9 و (thoughts_of_dropping_out  ،است

          ای طراحی شده که  گونهند. مراحل تحلیل بهکسنجی دقیق را فراهم می های روان امکان تحلیل

 .دنیت کرا رعا (Field, 2018) های آماری استاندارد

 ها سازی دادهآماده

باشند، با روش حذف  %5بررسی شده و اگر بیش از  4 مقادیر گمشده . شودمی  SPSSوارد دیتاست   CSVفایل

و  2یعنوان متغیرهای عدد به   gad7تا  gad1های ستون .شوند گذاری مدیریت میرکورد یا میانگین

 .شوند کدگذاری می Ordinal یا Nominal عنوانمتغیرهای جنسیت و سال تحصیلی به

 های توصیفیتحلیل

 تا gad1 های آماری مانند میانگین، انحراف استاندارد، و فرکانس برای نمرات ها، شاخص برای توصیف داده

gad7   آزمون .شود محاسبه میو نمره کل Kolmogorov-Smirnov  برای بررسی نرمال بودن توزیع

ها )مانند جنسیت یا سال  برای بررسی همگنی واریانس بین گروهLevene  آزمون .شود نمرات اجرا می

های  شوند تا توزیع نمرات و تفاوت ولید میت  9ایشود. نمودارهای هیستوگرام و جعبه تحصیلی( انجام می

 .گروهی )مانند زنان در مقابل مردان( نمایش داده شود

 

                                                           
1 missing values 
2 Scale 
3 Boxplot 
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 : یافته های پژوهشفصل چهارم
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های پژوهش اختصاص دارد که با هدف ارزیابی پایایی های حاصل از داده  فصل چهارم به ارائه و تحلیل یافته

 Mental health data of Mexican medical students بر روی دیتاستGAD-7 و روایی پرسشنامه

شود و نتایج ارائه می شوند. در  انجام می 27نسخه  SPSS افزارها با استفاده از نرم  انجام شده است. تحلیل

 های آماری مرتبط ارائه می گردد.شود، سپس تحلیل  های جامعه و نمونه توصیف می این فصل، ابتدا ویژگی

 ژگی های جامعه و نمونهتوصیف وی

       های دموگرافیک جامعه آماری و نمونه پژوهش اختصاص دارد که اطلاعات  این بخش به توصیف ویژگی

کند. جامعه آماری این پژوهش شامل پذیری نتایج فراهم می ها و تعمیم ای برای درک زمینه داده پایه

در نظرسنجی سلامت روان  2441که در سال  دانشجویان پزشکی یک دانشگاه خصوصی در مکزیک است

ها در  های آن ( است که داده%71.7دهی نرخ پاسخبا دانشجو ) 777اند. نمونه پژوهش شامل  شرکت کرده

است.   9تو سطح تحصیلا 2جنسیت، 4های مورد بررسی شامل سن موجود است. ویژگی  Figshareدیتاست

تر  برای ارائه تصویر کامل 5تشخیص قبلی افسردگی و 1ترک تحصیلافکار  همچنین، متغیرهای تکمیلی مانند

سنجی غنا  های روان اند و به تحلیل مرتبط شوند، زیرا این متغیرها با اضطراب عمومی از نمونه پیشنهاد می

ل مستق t های توصیفی )میانگین، انحراف استاندارد، فرکانس( و استنباطی )مانند آزمون بخشند. تحلیل می

 .صورت جامع گزارش شود های نمونه به شود تا ویژگی انجام می 27نسخه  SPSS ها( با برای مقایسه جنسیت

 

 هاو ارائه خروجی SPSS مراحل انجام تحلیل توصیفی در

 SPSSها در  سازی دادهآماده .4

  باز شد. SPSSدیتاست دانلود و در  CSVفایل 

می ، نوع متغیرها را تنظیم Variable Viewدر پس از چک کردن ستون ها و اطمینان از خواندن داده ها، 

 :کنیم

 

                                                           
1 age 
2 gender 
3 school_year و  semester 
4 thoughts_of_dropping_out 
5 previous_depression 
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Values Measure Name 

 Ordinal school_year "سال چهارم"= 4...   "سال اول"=1

 Ordinal semester "سال هشتم"= 8...   "ترم اول"=1

- Scale Age 

m= مرد  , f= زن   Nominal gender 

- Scale height , weight 

=بیش از نصف روز ها، 2=چند روز، 1=اصلا، 0

 =تقریبا هر روز3

Scale phq1,…, phq9 

 , Nominal thoughts_of_dropping_out =بله1=خیر ، 0
previous_depression_diagnosis , 
previous_depression_treatment 

نصف روز ها،  =بیش از2=چند روز، 1=اصلا، 0

 =تقریبا هر روز3

Scale gad1,…, gad7 

 , Nominal previous_anxiety_diagnosis =بله1=خیر، 0
previous_anxiety_treatment 

 Scale epw1,…, epw8 =زیاد3=متوسط، 2=کم، 1=هرگز، 0

 

 می کنیم:مقادیر گمشده را بررسی سپس 

 Analyze > Descriptive Statistics > Frequencies > Variables <انتخاب همه متغیرها   مسیر:

و در نهایت  Data > Select Cases > If condition می کنیم، رکوردها را حذف ها %5بیش از  برای

 داده باقی می ماند. 777تعداد 
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 تحلیل توصیفی متغیرها  .2

 مسیر:    

Analyze > Descriptive Statistics > Descriptives>  گزینه ها انتخاب  انتخاب متغیر<  : Mean ،

Std. Deviation ،Minimum ،Maximum. 

  رسم نمودارها:

Analyze > Descriptive Statistics > Explore >   انتخاب متغیر > ، نمودار نرمالیتی انتخاب هیستوگرام

 Discriptives :انتخاب گزینه  < plotsدر قسمت 

  (ageسن ) -

 

 

 

 است. 94-42 ، و دامنه سنی8/4~سال، انحراف استاندارد  24~میانگین  نشان دهنده جدول*

 *

 نمودار نشان دهنده توزیع سنی است.

Descriptive Statistics 

 N Minimum Maximum Mean Std. Deviation 

age 767 12 31 20.23 1.795 

Valid N (listwise) 767     
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-Qگونه که در شکل )نمودار  استفاده شد. همان Q-Qبودن توزیع متغیر سن، از نمودار  * برای بررسی نرمال

Q اند که نشان های ابتدایی و انتهایی از خط قطری فاصله گرفته شود، نقاط داده در قسمت( مشاهده می 

 دهنده انحراف از توزیع نرمال است.

 

 (gender) جنسیت -

 

 

 

 

 

 .%2/54زن،  995؛  %2/18مرد،  972جدول نشان دهنده درصد و تعداد زن و مرد است. * 
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 * نمودار نشان دهنده توزیع جنسی است.

  (school_year , semester) سطح تحصیلات - 

 

؛  %1/95، نفر سال اولی 279است.  دانشجویان سالهای مختلف تحصیلی* جدول نشان دهنده درصد و تعداد 

 . %7/22نفر سال چهارمی،  475؛  %9/47نفر سال سومی،  498؛  %1/29، نفر سال دومی 484

 

school_year 

 Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 35.6 35.6 35.4 273 اول سال 

 59.2 23.6 23.4 181 دوم سال

 77.2 18.0 17.9 138 سوم سال

 100.0 22.8 22.7 175 چهارم سال

Total 767 99.4 100.0  

Missing System 5 .6   

Total 772 100.0   
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؛ %7/29نفر ترم اولی،  489* جدول نشان دهنده درصد و تعداد دانشجویان ترم های مختلف تحصیلی است. 

نفر ترم ششمی،  55؛  %8/44نفر ترم پنجمی،  89؛  %1/29نفر ترم سومی،  484؛  %7/44نفر ترم دومی،  94

 . %4/7نفر ترم هشتمی،  55؛  %5/45نفر ترم هفتمی،  424؛  4/7%

semester 

 Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 23.9 23.9 23.7 183 1ترم 

 35.6 11.7 11.7 90 2ترم

 59.2 23.6 23.4 181 3ترم

 70.0 10.8 10.8 83 5ترم

 77.2 7.2 7.1 55 6ترم

 92.8 15.6 15.5 120 7ترم

 100.0 7.2 7.1 55 8ترم

Total 767 99.4 100.0  

Missing System 5 .6   

Total 772 100.0   
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 * نمودار نشان دهنده توزیع دانشجویان بر حسب سال تحصیلی آن ها است.

 تحصیلی آن ها است. ترم* نمودار نشان دهنده توزیع دانشجویان بر حسب 

 

  (thoughts_of_dropping_out , previous_depression) متغیرهای تکمیلی -

 

 

 

thoughts_of_dropping_out 

 Frequency Percent 

Valid 

Percent 

Cumulative 

Percent 

Valid 80.7 80.7 79.8 616 خیر 

 100.0 19.3 19.0 147 بله

Total 763 98.8 100.0  

Missing System 9 1.2   

Total 772 100.0    
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previous_depression_diagnosis 

 Frequency Percent 

Valid 

Percent 

Cumulative 

Percent 

Valid 91.4 91.4 90.8 701 خیر 

 100.0 8.6 8.5 66 بله

Total 767 99.4 100.0  

Missing System 5 .6   

Total 772 100.0   

 

 تحلیل استنباطی. 3

 ( gad7تا  gad1شده با جمع )محاسبه GAD-7ها در نمره کل دار بین گروه های معنی بررسی تفاوت  هدف :

  محاسبه نمره کلGAD-7 

Transform > Compute Variable > قرار دادن نام جدید : GAD_Total >                           :مسیر  

 gad1 + gad2 + gad3 + gad4 + gad5 + gad6 + gad7 : فرمول 

 .24تا  GAD-7 4ستون جدید با نمرات تشکیل یک خروجی: 

 

previous_depression_treatment 

 Frequency Percent 

Valid 

Percent 

Cumulative 

Percent 

Valid 92.6 92.6 91.8 709 خبر 

 100.0 7.4 7.4 57 بله

Total 766 99.2 100.0  

Missing System 6 .8   

Total 772 100.0   
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 نمودار هیستوگرام:

  آزمونt مستقل برای جنسیت 

Analyze > Compare Means > Independent-Samples T Test >                              :مسیر 

  gender_numeric : انتخاب متغیر گروه بندی < GAD_Total : انتخاب متغیر وابسته

 خروجی: 

Group Statistics 

gender_numeric N Mean Std. Deviation Std. Error Mean 

GAD_Total 217. 4.181 5.75 371 مرد 

 248. 4.908 7.91 393 زن



56 
 

 تحلیل:

 شود.ها رد می  است، یعنی فرض برابری واریانس Sig. < 0.05چون مقدار

 است، تفاوت بین دو گروه از نظر میانگین معنادار است. Sig. < 0.05از ردیف دوم جدول، از آنجا که 

 )اضطراب عمومی( برای دو گروه: GADمیانگین نمره 

( است. پس زنان سطح اضطراب 75/5طور معناداری بیشتر از مردان )(به 94/7میانگین اضطراب در زنان )

 اند. بالاتری از مردان نشان داده

 توان گفتمی ٪95است، یعنی با اطمینان  -54/4تا  -84/2ها بین برای اختلاف میانگین ٪95فاصله اطمینان 

 میانگین اضطراب زنان بیشتر است.

 

  آزمونANOVA برای سال تحصیلی 

 مسیر:

Analyze > Compare Means > One-Way ANOVA > انتخاب متغیر وابسته :                  

GAD_Total > لانتخاب متغیر مستق  : school_year > Post Hoc Tests > انتخاب گزینه : Tukey 

 خروجی: 

 

 

 

 

 

 

 دار استهای تحصیلی معنی  ین سالتفاوت بکه نشان می دهد،  p-valueو  F-valueجدولی با *

 

ANOVA 

GAD_Total 

 

Sum of 

Squares df Mean Square F Sig. 

Between Groups 514.970 3 171.657 8.011 .000 

Within Groups 16284.873 760 21.427   

Total 16799.843 763    
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 :تحلیل کلی

 25-94دهنده جامعه جوان و دانشجویی است، که با نرخ اضطراب سال نشان  24~میانگین  : سن % 

 )مشابه دانشجویان ایرانی( همخوانی دارد.

 آزمون :جنسیت t  های تواند به دلیل استرس میو این دهد زنان اضطراب بیشتری دارند، می نشان 

 .اجتماعی یا تحصیلی باشد

 تحصیلات: ANOVAبه دلیل فشار امتحانات اضطراب  های بالاتر دهد دانشجویان سال ، نشان می

 .دارندبیشتری 

 

 هتحلیل روایی پرسشنام

 روایی محتوایی -
 و  میزان ضروری بودن هر آیتم CVR . شود بی میارزیا CVI و  CVR  یروایی محتوایی با دو شاخص اصل

CVI  ادبیات بر اساسدهد. با توجه به نبود کارشناسان واقعی،  میزان مرتبط بودن کلی پرسشنامه را نشان می، 

 م.کنمی استفاده   .Spitzer et al )ها در بر اساس اهمیت آیتم(های منطقی  کارشناس فرضی با امتیاز 5از 

 های دیتاست ، امتیازات را بر اساس ادبیات موجود و ویژگیGAD-7پرسشنامهبرای روایی محتوایی  (

"Mental health data of 776 Mexican medical students" را با م؛ به علاوه آن کنتنظیم می

به  gad7 ) تا (gad1 هاکه آیتم می دهمبازخورد متخصصان و میانگین نمرات بالینی تأیید کرده و نشان 

 .شوندبندی می های بالینی رتبه یت بالینی و فراوانی در جمعیتترتیب اهم

بر  CVR بسیار مرتبط( و =1 مرتبط،  = 9کمی مرتبط،  = 2نامرتبط،  =4 ) 1تا  4بر مقیاس  CVI امتیازات

شود.  ضروری( محاسبه می = 2مفید اما غیرضروری،  =4غیرضروری،  = 4کارشناس ) 5اساس اجماع فرضی 

 .های دیتاست همخوانی دارد ها منطقی و با داده این داده

 

 CVR ( بودن آیتم ضروریارزیابی) 

ای  درجه 9( در مقیاس gad7تا  gad1هر کارشناس نظر خود را درباره ضروری بودن هر آیتم )

 کند.=ضروری( اعلام می2=مفید اما غیرضروری، 4=غیرضروری، 4)
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4کارشناس  آیتم 2کارشناس   9کارشناس   1کارشناس   5کارشناس    

gad1 2 2 2 2 2 

gad2 2 2 4 2 2 

gad3 2 2 2 2 4 

gad4 2 4 2 4 2 

gad5 2 2 2 4 2 

gad6 4 2 4 2 4 

gad7 4 4 2 4 4 

 : spssمراحل در 

 ها ایجاد فایل جدید و ورود داده. . 4

هر آیتم ایجاد می کنیم  ستون برای 7.یک فایل جدید می سازیم  File > New > Data، از منوی SPSS در 

(gad1_CVI ،gad2_CVI ،gad3_CVI ،gad4_CVI ،gad5_CVI ،gad6_CVI ،gad7_CVI.)   5و 

 س ایجاد می کنیم. سپس داده ها را وارد می کنیم.کارشنا 5ردیف برای 

 . یافتن تعداد ضروری ها2

Analyze > Descriptive Statistics > Frequencies > Variables = gad1_CVR ، 

gad2_CVR ، gad3_CVR ، gad4_CVR ، gad5_CVR ، gad6_CVR ، gad7_CVR > OK 

 خروجی ها: 

 

 

 

 

 

 

 

gad1_CVR 

 Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 2 5 100.0 100.0 100.0 

gad2_CVR 

 Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 1 1 20.0 20.0 20.0 

2 4 80.0 80.0 100.0 

Total 5 100.0 100.0  
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 : (𝑛𝑒 به سوال داده اند )  -ضروری - 2تعداد کارشناسانی که نمره 

gad7 gad6 gad5 gad4 gad3 gad2 gad1 

4 2 1 9 1 1 5 

 

 

gad3_CVR 

 Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 1 1 20.0 20.0 20.0 

2 4 80.0 80.0 100.0 

Total 5 100.0 100.0  

gad4_CVR 

 Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 1 2 40.0 40.0 40.0 

2 3 60.0 60.0 100.0 

Total 5 100.0 100.0  

gad6_CVR 

 Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 1 3 60.0 60.0 60.0 

2 2 40.0 40.0 100.0 

Total 5 100.0 100.0  

gad7_CVR 

 Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 1 4 80.0 80.0 80.0 

2 1 20.0 20.0 100.0 

Total 5 100.0 100.0  
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 بر اساس فرمول CVR. مقادیر 9

CVR =
𝑛𝑒  − (

𝑁
2

)

𝑁
2

=
𝑛𝑒  − (2.5)

2.5
 

gad7_CVR gad6_CVR gad5_CVR gad4_CVR gad3_CVR gad2_CVR gad1_CVR 

7/4- 2/4- 7/4 2/4 7/4 7/4 4 

 4،2،9،5و طبق خروجی به دست آمده، سوالات  باشد 7/4باید بالای  CVRبا توجه به اینکه مقدار :  تحلیل

دهنده عدم پوشش نشان ، 7/4زیر  CVR با مقدار 1،7،7به عنوان سوالات ضروری تایید می شوند و سوالات 

 . هستندکامل آن از اضطراب 

 

 CVI (ارزیابی مرتبط بودن آیتم) 

 Spitzer ها در امتیازات بر اساس اهمیت بالینی آیتماین دهد.  امتیاز می 1تا  4هر کارشناس به هر آیتم از 

et al. (2006)  هایی مثلشده است. آیتمهای دیتاست تنظیم  و توزیع داده gad1(واحساس بی )قراری 

gad3  (که شایع )که کنند، در حالیتر هستند، امتیاز بالاتری دریافت می تر و کلیدی نگرانی بیش از حد 

gad7  (به دلیل ابهام احتمالی در دانشجویان امتیاز کمتری دارد )ترس از اتفاق بد. 

 5کارشناس  1کارشناس  9کارشناس  2کارشناس  4کارشناس  آیتم

gad1 1 1 1 1 9 

gad2 1 9 1 9 1 

gad3 1 1 1 9 1 

gad4 9 9 9 2 9 

gad5 1 9 9 1 9 

gad6 9 2 9 9 2 

gad7 2 9 2 2 9 
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 : spssمراحل در 

 ها ایجاد فایل جدید و ورود داده. 4

هر آیتم ایجاد می کنیم ستون برای  7.یک فایل جدید می سازیم  File > New > Data، از منوی SPSS در 

(gad1_CVI ،gad2_CVI ،gad3_CVI ،gad4_CVI ،gad5_CVI ،gad6_CVI ،gad7_CVI.)   5و 

 س ایجاد می کنیم. سپس داده ها را وارد می کنیم.کارشنا 5ردیف برای 

  Variable View تنظیم متغیرها در  .2

:  برای هر ستون،   Variable View در    

 Type: Numeric .0 =Decimals . CVI برایgad1   = Label .= Values پس مقیاس عددی است ،

 .نیازی به برچسب نیست

 ساخت متغیرهای جدید. 9

 داده و سوال را مرتبط دانسته اند. 1یا  9برای هر سوال، باید تعیین کنیم که چه تعداد از کارشناسان امتیاز 

Transform > Compute variable > Target Variables = CVI1 > Numeric Expression = 

(gad1_CVI >= 3) > OK 

 است. 4و  4با تکرار این دستور برای هر سوال، یک ستون جداگانه دریافت می کنیم که شامل مقادیر 

 :خروجی 

 

 (CVI)مقدار  . محاسبه میانگین هر ستون1

Analyze > Descriptive Statistics > Descriptives > Variables = CVI1,…,CVI7 > OK 
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 ها هستند.  I-CVIخروجی: مقادیر میانگین که همان 

 

 

 

 

 

درصد از کارشناسان، این سوال  84، در می یابیم که 84/4مقدار میانگین ، به دلیل gad4برای مثال در سوال 

 را مرتبط دانسته اند.

 کل( CVI. محاسبه شاخص کلی )5

 کل  CVI= مقدار  829/4به دست آمده، داریم:                                 CVIبا میانگین گیری از مقادیر 

و خروجی به دست آمده در قسمت قبل دقیقا  باشد 4.8ید بالای با CVIقدار م:  با توجه به اینکه  تحلیل

 همین مطلب را منعکس می کند، سوالات از نظر مرتبط بودن در روایی محتوایی تایید می شوند.

 نمودار ها 

 به صورت زیر: SPSS. وارد کردن داده ها در 4

GAD CVR CVI 

4 4 4 

2 7/4 4 

9 7/4 4 

1 2/4 8/4 

5 7/4 4 

7 2/4- 7/4 

7 7/4- 1/4 

Descriptive Statistics 

 N Mean 

CVI_1 5 1.00 

CVI_2 5 1.00 

CVI_3 5 1.00 

CVI_4 5 .80 

CVI_5 5 1.00 

CVI_6 5 .60 

CVI_7 5 .40 

Valid N (listwise) 5  
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 CVRبرای  4رسم نمودار ستونی .2

Graphs > Legacy Dialogs > Bar… > Simple > Define > Category Axis = GAD > Bar 

Represent = Other Statistic > Variable = CVR > OK 

 خروجی : 

 

 است. GADهر سوال  CVR* نمودار ستونی نشان دهنده مقدار 

 

 CVI. رسم نمودار ستونی برای 9

Graphs > Legacy Dialogs > Bar… > Simple > Define > Category Axis = GAD > Bar 

Represent = Other Statistic > Variable = CVI > OK 

 

 

                                                           
1  Bar chart 
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 خروجی: 

 

 

 

 

 

 *

 است. GADهر سوال  CVRنمودار ستونی نشان دهنده مقدار 

 CVIو  CVR. رسم نمودار ستونی همزمان برای 1

Graphs > Chart Builder > Clustered Bar > محور افقی = GAD > محور عمودی = CVR , CVI 

> OK 

 خروجی:
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    هستند و قابل قبول اند؛ 8/4بالای  CVIقدار مدارای  gad1 ,…, gad5* با توجه به نمودار، سوالات 

 دارند و قابل قبول هستند.  7/4بالای   CVRمقدار  gad1,gad2,gad3, gad5همچنین سوالات 

 

 روایی سازه  -

 ،. در این پژوهشد یا خیرسنجمیعنوان سازه واحد  اضطراب را به  GAD-7کند که آیا روایی سازه بررسی می

روایی  همچین ،شود استفاده می (CFA) ی تحلیل عاملی تأییدو  (EFA) تحلیل عاملی اکتشافی های روش

 شود. همگرا و واگرا نیز بررسی می

  روشEFA 

 کنیم:از دو شاخص کلیدی استفاده می SPSS در 

   4 .4KMO  

 یا خیر. دهد آیا حجم نمونه برای تحلیل عاملی مناسب است نشان می این شاخص    

 = نامناسب 74/4زیر  ،قابل قبول = 74/4-79/4 ،= خیلی خوب 84/4-89/4 ،= عالی 94/4 بالاتر از  معیار:    

   2 .Bartlett’s Test of Sphericity  

 وجود دارد یا خیر. همبستگی کافی  کند آیا بین متغیرهابررسی می این شاخص     

 ها مناسب تحلیل عاملی هستند. داده ، آنگاهباشد Sig < 0.05اگر مقدار  :معیار    

 :مسیر 

Analyze > Dimension Reduction > Factor > Variables :  gad1 تا   gad7 >[ Descriptives: 

Initial Solution , KMO and Bartlett’s test of sphericity ] > [ Extraction: Principal 

Component Analysis > Scree Plot > Extract > Eigenvalues greater than 1 ] > 

[Rotation: Varimax > Loading plots ] > [ Scores : Save as variables ] > Run 

 

                                                           
1 Kaiser-Meyer-Olkin Measure 
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 : ( 4) خروجی

 

 

 

 : Bartlett’s Test و KMOتحلیل جدول

 KMO = 0.900شاخصباشد. در این خروجی،  7/4،  باید بالا تر از KMOطبق مطالعات، مقدار شاخص * 

 تند.آل هس ها برای تحلیل عاملی ایده گیری بسیار مناسب است و داده دهد کفایت نمونه نشان میاست، که 

بین متغیرها همبستگی  دهد که نشان می ،Bartlettآزمون در  Sig < 0.05  (Sig = 0.000)مقدار * 

 یعنی ساختار عاملی قابل استخراج است. ؛دارددار وجود  معنی

 ند.هست مناسبها کاملاً برای تحلیل عاملی  نتیجه: داده *

 

 ( : 2خروجی )

 

 

 

 

 

 : Communalitiesتحلیل جدول 

شده تبیین نشان می دهد چه درصدی از واریانس هر سؤال توسط عامل استخراج  Extraction* مقدار 

 شوند. محسوب می یعال ،7/4بالاتر از  و مقادیر هستندقابل قبول  1/4 مقادیر بالاتر از شود.می

 

KMO and Bartlett's Test 

Kaiser-Meyer-Olkin Measure of Sampling Adequacy. .900 

Bartlett's Test of Sphericity Approx. Chi-Square 2740.400 

df 21 

Sig. .000 

Communalities 

 Initial Extraction 

gad1 1.000 .682 

gad2 1.000 .769 

gad3 1.000 .715 

gad4 1.000 .649 

gad5 1.000 .402 

gad6 1.000 .483 

gad7 1.000 .475 

Extraction Method: Principal Component Analysis. 
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                                تفسیر Extraction سوالات

Gad1 0.682 خوب 

Gad2 0.769 عالی 

Gad3 0.715 عالی 

Gad4 0.649 خوب 

Gad5 0.483 نسبتا پایین اما قابل قبول 

Gad6 0.483 قابل قبول 

Gad7 0.475 هنوز ولی بقیه از ترپایین 

 قبول قابل

ی  سازه. به این معنا که، بار عاملی مناسبی دارند و در یک عامل مشترک نقش دارند لاتاسوی همه :نتیجه

 گیری شده است. صورت همگن توسط همه سؤالات اندازه اضطراب به

 ( : 9خروجی ) 

 : Total Variance Explainedتحلیل جدول 

،  دهد می توضیح را کل واریانس %799/59 اول مؤلفه. است مؤلفه هر توضیحی واریانس دهنده نشان جدول

 قوی بعدی تک ساختار دهنده نشان  Spitzer et al. (2006) مطالعات طبق و است %54 آستانه بالای که

GAD-7 (عمومی اضطراب )که دهد می نشان اول مؤلفه برای %799/59 تجمعی توضیحی واریانس. است 

. دارد همخوانی دیتاست نمرات میانگین با که ،هستند مرتبط عامل یک به عمدتاً( gad7 تا gad1) ها آیتم

 بعدی یک GAD-7 کندمی تأیید که، دارند %44 از کمتر واریانسحدودا ( هفتم تا دوم) بعدی های مؤلفه

 .سنجدمی  اضافی عوامل بدون را اضطراب پرسشنامه زیرا، کندمی تقویت را سازه روایی نتیجه این. است

Total Variance Explained 

Component 

Initial Eigenvalues Extraction Sums of Squared Loadings 

Total % of Variance Cumulative % Total % of Variance Cumulative % 

1 4.175 59.639 59.639 4.175 59.639 59.639 

2 .736 10.513 70.152    

3 .606 8.664 78.816    

4 .553 7.906 86.722    

5 .396 5.657 92.379    

6 .335 4.787 97.166    

7 .198 2.834 100.000    

Extraction Method: Principal Component Analysis. 
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 ( : 1خروجی )

 

 : Scree Plot نمودارتحلیل 

Scree Plot ده دهن نشان یکشود و افت شدید پس از مؤلفه  برای تعیین تعداد عوامل مناسب استفاده می

که بالای آستانه  ،( است4)بالای  471/1 ~ یکمؤلفه  Eigenvalue مقدار است. GAD-7بعدی  ساختار تک

Kaiser (Eigenvalue > 1)  دوه دهد. افت سریع به مؤلف واریانس را توضیح می %799/59است و 

(0.8~Eigenvalueو صاف شدن خط نشان می ) ( کافی است اضطراب عمومی دهد که فقط یک عامل )، 

نند. این نتیجه با دیتاست دانشجویان پزشکی ک میهستند و واریانس کمی اضافه  4های بعدی زیر  زیرا مؤلفه

روایی سازه را تأیید یک، با افت در مؤلفه  ها شایع است. این نمودار که اضطراب عمومی در آن ،همخوانی دارد

مؤلفه  Eigenvalueسازگار است. اگر  COSMIN (Mokkink et al., 2018)کند و با استانداردهای می

 ( باشد.gad7های ضعیف )مثل  ممکن بود نیاز به بررسی آیتم ،بود 1کمتر از  یک
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 ( : 5خروجی ) 

 

 

 

 

 

 : Component Matrix تحلیل جدول

 بارهای. دهد می نشان را(  عمومی اضطراب ) یک مؤلفه روی بر GAD-7 های آیتم 4عاملی بارهایاین جدول 

 نگرانی) ها آیتم این قوی ارتباط دهنده نشان(   gad3  :  0.845 , gad2 :  0.877 , gad1 :  0.826) بالا

 تر پایین بارهای. کندمی تأیید را سازه روایی و است 4.5 آستانه بالای که ،است اصلی عامل با( قراری بی و

(gad6 : 0.695 , gad5 : 0.634 gad7 : 0.689 , )دهنده نشان است ممکن اما، هستند قبول قابل هنوز 

 . باشد پزشکی دانشجویان نمونه در( پذیری تحریک و شدید قراری بی) ها آیتم این نسبی ضعف

 نمیانگی که ،دارد همخوانی دیتاست با نتیجه این. است خوب همگرایی دهنده نشان 78/4 ~ عاملی بار میانگین

0.7  ~gad2  (بالا )0.6 و  ~gad5  (پایین )است . 

 ( :7خروجی )

 

 

 : Rotated Component Matrix تحلیل جدول

 و است %54 بالای یک مؤلفه توضیحی واریانس زیرا ،است GAD-7 بودن بعدی تک دهنده نشان پیام

 از) عاملی بارهای که است این معنای به چرخش عدم(. Scree Plot از) هستند 4 زیر دیگر هایمؤلفه

                                                           
1 Factor Loadings 

Component Matrixa 

 

Component 

1 

gad1 .826 

gad2 .877 

gad3 .845 

gad4 .806 

gad5 .634 

gad6 .695 

gad7 .689 

Extraction Method: Principal Component Analysis. 

a. 1 components extracted. 
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Component Matrix )کندیم تقویت را سازه روایی نتیجه این. هستند معتبر اضافی تنظیم به نیاز بدون، 

 Spitzer et al. (2006) مطالعات با که سنجدمی واحد سازه یک عنوان به را عمومی اضطراب GAD-7 زیرا

 نممک بودن بعدی تک این ،پزشکی دانشجویان دیتاست در. است سازگار( % 74~ واریانس با بودن بعدی تک)

 .باشد 4افسردگی با اضطراب همبودی دلیل به است

 

  روشCFA 

کند آیا مدل نظری پرسشنامه )مثل مدل تحلیل عاملی تأییدی بخشی از روایی سازه است که بررسی می

مدل ، کندکه ساختار را کشف می EFAبر خلاف  CFAها همخوانی دارد یا خیر.  ( با دادهGAD-7بعدی تک

در این پژوهش، با علم کند. را محاسبه می TLIو  CFI ،RMSEAمانند  2های برازش کند و شاخصرا تست می

 9ساختاری سازی معادلات  نیاز به مدل CFA - ،کندرا پشتیبانی نمی CFAطور مستقیم به SPSSکه به این 

 می کنیم.های جایگزین استفاده  از روش -موجود است  AMOSدارد که در افزونه 

 برای چک بارهای عاملی Regression: جایگزینروش 

CFA (.می کنیم)هر آیتم را با نمره کل رگرس  می کنیم سازی را با رگرسیون خطی شبیه 

 مسیر:

Analyze > Regression > Linear > وابسته  : gad1 )هر آیتم جداگانه(  مستقل  <  : GAD_Total 

 : GAD1برای ها  خروجی

 : Model Summaryجدول 

                                                           
1 PHQ-9 
2 Fit Indices 
3 SEM 

Model Summary 

Model R R Square Adjusted R Square 

Std. Error of the 

Estimate 

1 .817a .668 .667 .497 

a. Predictors: (Constant), GAD_Total 
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R = 0.817  همبستگی خطی بین :gad1  وGAD_Total ( قوی استr=0.8170.7 . بالای)، که نشان 

 دهنده ارتباط نزدیک آیتم اول با کل پرسشنامه است.

R Square = 0.668: 66.8%  واریانسgad1  توسطGAD_Total که مقدار بالایی  ،شودتوضیح داده می

 .CFA, Hair et al., 2010)در  AVEبرای  5/4 <)استاندارد  .کنداست و روایی همگرا را تأیید می

Adjusted R Square = 0.667  نزدیک به  779با حجم نمونهR Square دهنده تعمیم که نشان ،است 

 بینی است. دهنده خطای پایین پیش نشان Std. Error of the Estimate = 0.667پذیری خوب است. 

 : ANOVAجدول 

 

 Regression Sum of Squares = 378.785 :مدل توسط شده داده توضیح واریانس. 

 Residual Sum of Squares = 188.331 :شدهن داده توضیح واریانس. 

 F = 1530.578, df = 1 (Regression) , p = 0.000 :است دارمعنی مدل (p < 0.05) ،یعنی 

GAD_Total برای خوبی کنندهبینی پیش gad1 آیتم زیرا ،کندمی تقویت را سازه روایی نتیجه این. است 

gad1 دارد همخوانی اضطراب کل با. 

 :Coefficients جدول 

ANOVAa 

Model 

Sum of 

Squares df Mean Square F Sig. 

1 Regression 378.785 1 378.785 1530.578 .000b 

Residual 188.331 761 .247   

Total 567.117 762    

a. Dependent Variable: gad1 

b. Predictors: (Constant), GAD_Total 

Coefficientsa 

Model 

Unstandardized 

Coefficients 

Standardized 

Coefficients 

t Sig. B Std. Error Beta 

1 (Constant) .166 .032  5.213 .000 

GAD_Total .150 .004 .817 39.123 .000 

a. Dependent Variable: gad1 
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Constant (B=0.166, t=5.213, p=0.000)  :پایه مقدار gad1 وقتی GAD_Total = 0 باشد ،

 .است دارمعنی

: GAD_Total (B=0.150, Std. Error=0.004, Beta=0.817, t=39.123, p=0.000) B=0.150   
 افزایش واحدGAD_Total، gad1  ، 0.150 افزایش واحد هر ازای به) است مثبت شیب دهنده نشان

 معنی p = 0.000 با t = 39.123. دهد می نشان را قوی شده استاندارد همبستگی Beta=0.817(. یابدمی

 .کندمی تأیید را پرسشنامه کل با آیتم ارتباط که ،است دار

 

  ییواگراهمگرایی و 

 هاداده سازیآماده. 4

 :کنید استفاده Transform > Compute Variable زا

GAD_Total = gad1 + gad2 + gad3 + gad4 + gad5 + gad6 + gad7 

PHQ_Total = phq1 + phq2 + ... + phq9 

Epworth_Total = epworth1 + epworth2 + ... + epworth8 

 گمشده هایداده مدیریت. 2

 واگرا و همگرا روایی برای همبستگی محاسبه. 9

 مسیر:

Analyze > Correlate > Bivariate > متغیرها : GAD_Total جمع(   gad1-gad7( , PHQ_Total 

phq1-phq9( , Epworth_Totalجمع(  جمع(   epworth1-epworth8( > Correlation 

Coefficients > Pearson >  Test of Significance > Two-tailed  Flag significant و 

correlations > OK 
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 :خروجی 

 

 

 

 

 

 

 :Correlations تحلیل جدول 

 است طبیعی کاهش این. است گمشده های داده دلیل به رکورد 48 حذف دهنده نشان N = 758 نمونه حجم

  .است کافی همبستگی برای( 758) ماندهباقی حجم و

 مانند پیوسته شبه متغیرهای برای که ،شده انتخاب( Bivariate فرضپیش) Pearson:  همبستگی روش

 . است مناسب GAD , PHQ , Epworth کل نمرات

 44/4 سطح در داریمعنی دهنده نشان با که، هستند( 44/4 از کمتر) 444/4 ها p-value همه: داریمعنی

(2-tailed )زیرا، دارد همخوانی بزرگ نمونه حجم با این. است N=758 های همبستگی به بالایی حساسیت 

 .دهد می کوچک

 اندازه اساس بر تحلیل. دهد می نشان را دو به دو روابط که است x 9 9 همبستگی ماتریس یک خروجی

 4همگرا روایی بررسی برای خروجی این. شود می انجام( p > 0.05) داریمعنی و رابطه قدرت ، (r) همبستگی

 مثل غیرمرتبط های سازه با کم همبستگی) 2واگرا و( افسردگی مثل مرتبط های سازه با بالا همبستگی)

 .است مفید( آلودگیخواب

 

 

                                                           
1 Convergent Validity 
2 Divergent Validity 

Correlations 

 GAD_Total PHQ_total EPW_total 

GAD_Total Pearson Correlation 1 .682** .386** 

Sig. (2-tailed)  .000 .000 

N 758 758 758 

PHQ_total Pearson Correlation .682** 1 .388** 

Sig. (2-tailed) .000  .000 

N 758 758 758 

EPW_total Pearson Correlation .386** .388** 1 

Sig. (2-tailed) .000 .000  

N 758 758 758 

**. Correlation is significant at the 0.01 level (2-tailed). 
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 :PHQ_Total و GAD_Total همبستگی

( r²=0.465) % 5/17 که ،است( 5/4 بالای) قوی مثبت همبستگی دهنده نشان r = 0.682: قدرت و اندازه

 مومیع اضطراب نزدیک ارتباط دهنده نشان قوی تا متوسط همگرایی این. دهد می توضیح را مشترک واریانس

(GAD-7 )افسردگی با (PHQ-9 )شیوع) پزشکی دانشجویان در اختلال دو این بالینی همبودی با که ،است 

 .دارد همخوانی( % 94-24 ~

 .رود می انتظار 758 نمونه حجم با که، است دار معنی رابطه دهنده نشان p = 0.000 < 0.001: داریمعنی

 غربالگری ابزار دو هر) مرتبط های سازه PHQ-9 و GAD-7 زیرا ،کندمی تأیید را همگرا روایی نتیجه این

 تمایز که ،باشد حد از بیش همپوشانی دهنده نشان است ممکن r > 0.6 ،حال این با. هستند( روان سلامت

GAD-7 کندمی کم را. 

 :EPW_Total و GAD_Total همبستگی

( r² = 0.149) % 9/41 که ،است( 9/4-5/4) متوسط مثبت همبستگی دهنده نشان r=0.386: قدرت و اندازه

، است آلودگی خواب از GAD-7 تمایز دهنده نشان متوسط واگرایی این. دهد می توضیح را مشترک واریانس

 .دارد همخوانی( آلودگیخواب و اضطراب) ها سازه این جداگانه ماهیت با که

 کندمی تأیید را واگرایی r کم قدرت اما ،است دار معنی رابطه دهنده نشان p = 0.000 < 0.001: داریمعنی

 (.Fornell & Larcker, 1981 واگرا برای r < 0.4 استاندارد)

 داشته ویق همبستگی آلودگی خواب با نباید عمومی اضطراب زیرا ،کندمی پشتیبانی را واگرا روایی نتیجه این

 اباضطر به منجر تحصیلی استرس) دانشجویان در همبودی دلیل به است ممکن r = 0.386 ،حال این با. باشد

 .باشد( آلودگی خواب و

 : EPW_Total و PHQ_Total همبستگی

 را مشترک واریانس % 9/41 که ،است متوسط مثبت همبستگی دهنده نشان r = 0.386: قدرت و اندازه

 زیرا ،است منطقی( Epworth) آلودگیخواب و( PHQ-9) افسردگی برای رابطه این. دهد می توضیح

 .است همراه خواب اختلالات با اغلب افسردگی

 .است دار معنی رابطه دهنده نشان p = 0.000 < 0.001: داریمعنی

 و افسردگی همبودی دهنده نشان زیرا ،کندمی کمک دیتاست کلی روایی به غیرمستقیم همبستگی این

 .کندمی تأیید را Epworth با واگرایی مستقیماً GAD-7 برای اما ،است آلودگیخواب
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 روایی ملاکی -

دهد  با معیارهای خارجی معتبر اشاره دارد و نشان می GAD-7به میزان همخوانی پرسشنامه  4روایی ملاکی

که آیا نمرات حاصل از این ابزار با نتایج ابزارهای استاندارد یا متغیرهای مرتبط همخوانی دارد یا خیر. در این 

شود. روایی همزمانی  ارزیابی میی بینپیشروش اصلی همزمانی و  با دو زیر GAD-7پژوهش، روایی ملاکی 

مبستگی قوی دارد )به دلیل همبودی اضطراب ه ، PHQ-9با نمره کل GAD-7کند که آیا نمره کل میبررسی 

 تواند متغیرهای آیندهمی GAD-7نمره کل کند که آیا  بینی بررسی می و افسردگی(، در حالی که روایی پیش

 .بینی کند را پیش 2نگر مانند افکار ترک تحصیل

زیرا دانشجویان پزشکی گروه پراسترسی هستند که اضطراب  ،ای دارد روایی ملاکی در این دیتاست اهمیت ویژه

 . تمایز داشته باشد 9آلودگیو با خواب همبودی داشته باشد یافسردگممکن است با  عمومی

 :SPSS مراحل اجرا در 

 ها سازی دادهآماده

 م.کنیمی محاسبه   Transformدر را Epworth_Totalو  GAD_Total  ،PHQ_Totalنمره کل 

 م.کنیمی های گمشده را مدیریت  دادهسپس 

 

 1روایی همزمانی 

 :مسیر

Analyze >Correlate > Bivariate >Variables: GAD_Total, PHQ_Total, Epworth_Total 

>Correlation Coefficients:Pearson>Test of Significance:Two-tailed,Flag significant 

correlations > OK 

 

 

                                                           
1 Criterion Validity 
2 thoughts_of_dropping_out 
3 Epworth 
4 Concurrent Validity 
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 ( : همبستگیماتریس )خروجی 

 :Correlations  جدول تحلیل

به طور مفصل تحلیل شده است. در ادامه خلاصه ای آورده شده  همگرایی و واگرایی}این جدول، در قسمت 

 {است.

 .همبستگی تحلیل برای کافی حجم ؛(است شده حذف گمشده دادهمورد  47) مورد 759 :نمونه حجم

 .Epworth و GAD، PHQ مانند پیوسته متغیرهای برای 4پیرسون همبستگی :روش

 (.p=0.000) هستند دارمعنی p<0.01 سطح در روابط تمام :داریمعنی

 

 :کلیدی نتایج

4 .GAD–PHQ 

    *r=0.682 → مثبت و قوی همبستگی (r²=0.465.) 

 (.اندمرتبط افسردگی و اضطراب) همگرا روایی دهندهنشان*    

 (.r>0.6) دارد وجود هاسازه  بین زیاد همپوشانی احتمال*    

                                                           
1 Bivariate 

Correlations 

 GAD_Total PHQ_Total EPW_Total 

GAD_Total Pearson Correlation 1 .682** .386** 

Sig. (2-tailed)  .000 .000 

N 759 759 759 

PHQ_Total Pearson Correlation .682** 1 .388** 

Sig. (2-tailed) .000  .000 

N 759 759 759 

EPW_Total Pearson Correlation .386** .388** 1 

Sig. (2-tailed) .000 .000  

N 759 759 759 

**. Correlation is significant at the 0.01 level (2-tailed). 
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2 .GAD–Epworth 

    *r=0.386 → متوسط مثبت همبستگی (r²=0.149.) 

 (.متمایزند آلودگی خواب و اضطراب) واگرا روایی تأییدکننده*    

 .باشد تحصیلی استرس از ناشی است ممکن ارتباط*    

9 .PHQ–Epworth 

    *r=0.386 → متوسط مثبت همبستگی (r²=0.149.) 

 .خواب اختلالات با افسردگی ارتباط دلیلبه است منطقی*    

 

  4بینیپیشروایی 

 : مسیر 

 Analyze > Regression > Linear > Dependent Variable : GAD_Total > 

Independent(s) : thoughts_of_dropping_out > Method: Enter > Statistics : 

Estimates , Model fit , R squared change > OK 

 ( :4)خروجی 

 .هدمی د نشان را مدل کلی برازش جدول این:  Model Summaryتحلیل جدول 

 R = 0.282 :بین( 1/4-2/4) متوسط مثبت خطی همبستگی GAD_Total و   

thoughts_of_dropping_out 8 که، است% (R Square = 0.080 )واریانس GAD_Total را   

                                                           
1 Predictive Validity 

Model Summary 

Model R 

R 

Square 

Adjusted R 

Square 

Std. Error of 

the Estimate 

Change Statistics 

R Square 

Change 

F 

Change df1 df2 

Sig. F 

Change 

1 .282a .080 .079 4.503 .080 65.261 1 753 .000 

a. Predictors: (Constant), thoughts_of_dropping_out 
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 نشان که ،است R Square به نزدیک N =754 حجم با Adjusted R Square = 0.079. دهد می توضیح

 (.نمونه حجم برای تنظیم دلیل به جزئی کاهش) است خوب پذیری تعمیم دهنده

Std. Error of the Estimate = 4.503  :خوب دقت دهنده نشان که ،است کم مدل بینیپیش خطای 

 .است

Change Statistics  مقدار : R Square Change = 0.080 ، F Change = 65.261 ، df1 = 1 ،

df2 = 753  وSig. F Change = 0.000 است مدل به مستقل متغیر دار معنی شدن اضافه دهنده نشان. 

 است متوسط که ،دهد می توضیح تحصیل ترک افکار با را اضطراب واریانس % 8 مدل در کل می توان گفت،

 نتیجه. این است پزشکی دانشجویان در تحصیلی استرس و اضطراب همبودی دهنده نشان و ؛دار معنی اما

 .است( جنسیت یا سن مانند) دیگر عوامل دهنده نشان پایین R² اما ،کندمی  تقویت را بینیپیش روایی

 ( :2خروجی)

 

 .کندمی  بررسی را مدل کلی داری معنی جدول این:  ANOVAتحلیل جدول 

Regression Sum of Squares = 1323.342  ،df = 1  ،Mean Square = 1323.342  ،        

F = 65.261 و Sig. = 0.000  است دار معنی مدل توسط شده داده توضیح واریانسبیان می کند که 

(p<0.05) است اضطراب بر تحصیل ترک افکار تأثیر دهنده نشان که. 

Residual Sum of Squares = 15269.209  ، df = 753و Mean Square = 20.278   مقدار 

 را نشان می دهد. شده نداده توضیح واریانس

 Total Sum of Squares = 16592.551 و df = 754را نشان می دهد. واریانس کل هم میزان 

 واریانس %8 که ،است دار معنی مدل دهنده نشان p=0.000 با F=65.261 به طور کلی می توان گفت،

                   ، کندمی تأیید را ملاکی روایی و دارد همخوانی N=754 حجم با این. دهد می توضیح را اضطراب

ANOVAa 

Model Sum of Squares df Mean Square F Sig. 

1 Regression 1323.342 1 1323.342 65.261 .000b 

Residual 15269.209 753 20.278   

Total 16592.551 754    

a. Dependent Variable: GAD_Total 

b. Predictors: (Constant), thoughts_of_dropping_out 
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 با %24 ،دانشجویان در تحصیلی استرس به توجه با) کندمی بینیپیش را تحصیل ترک افکار  GAD-7 زیرا

 (.ترک افکار

 ( :9خروجی)

 

Coefficientsa 

Model 

Unstandardized Coefficients 

Standardized 

Coefficients 

t Sig. B Std. Error Beta 

1 (Constant) 6.211 .182  34.068 .000 

thoughts_of_dropping_out 3.361 .416 .282 8.078 .000 

a. Dependent Variable: GAD_Total 

 .دهدمی نشان را مدل ضرایب جدول این:  Coefficientsتحلیل جدول 

 Constant :پایه مقدار GAD_Total وقتی thoughts_of_dropping_out=0 است دار معنی ،باشد 

 .است( 6.211) ترک افکار بدون اضطراب میانگین دهنده نشان و

thoughts_of_dropping_out  : B=3.361افزایش واحد هر ازای به) است مثبت شیب دهنده نشان 

 را متوسط شده استاندارد همبستگی Beta=0.282(. یابد می افزایش GAD_Total 3.361 ،ترک افکار

 .است دار معنی p=0.000 با t=8.078. دهد می نشان

 %8 که ،است اضطراب بر ترک افکار متوسط تأثیر دهنده نشان Beta=0.282 به طور کلی می توان گفت،

 را تحصیل ترک افکار GAD-7 زیرا ،کندمی تأیید را بینیپیش روایی نتیجه این. دهد می توضیح را واریانس

 افکار با %24) پزشکی دانشجویان در همبودی با که ،کند می بینیپیش اضطراب با مرتبط متغیر عنوان به

 .ارندد بالاتری اضطراب ترک افکار با افراد یعنی، است عملی تأثیر دهندهنشان B=3.361. دارد همخوانی( ترک

 

 کلی تحلیل

 متوسط بینیپیش روایی دهنده نشان که ،است دارمعنی p = 0.000 و  R² = 0.080 با رگرسیون مدل

GAD-7 حجم با این. است تحصیل ترک افکار برای N=754 روابط به بالایی حساسیت و دارد همخوانی 

 روایی F = 65.261 اما ،است( جنسیت یا سن مانند) دیگر عوامل دهنده نشان پایین R². دهد می ضعیف

 .کندمی تأیید را کلی
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 نمودار پراکندگی برای نمایش بصری همبستگی 

 مسیر:

Graphs > Chart Builder > Scatter / Dot > Simple Scatter > X – Axis : PHQ_Total  >      

Y – Axis : GAD_Total > OK 

 :خروجی 

 

 تحلیل پایایی پرسشنامه
 

 روش آلفای کرونباخ -

آلفای شود.  محاسبه می GAD- 7های  برای ارزیابی همسانی درونی آیتم 4در این بخش، آلفای کرونباخ

عنوان قابل قبول و  به 7/4ها است و مقدار بالای  ها به آیتم دهنده میزان هماهنگی بین پاسخ کرونباخ نشان

 .شود عنوان خوب در نظر گرفته می به 8/4بالای 

                                                           
1 Cronbach’s Alpha 
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 ها سازی داده آماده( 4

 اجرای تحلیل آلفای کرونباخ( 2

 مسیر:

 Analyze > Scale > Reliability Analysis > Items : gad1  ، gad2 ، gad3   ، gad4 ، gad5   ،

gad6 ، gad7 > Model : Alpha > Statistics : Item-Total Statistics -> مبررسی تأثیر حذف هر آیت         

, Scale if Item Deleted -> آیتم هر بدون آلفا مشاهده   , Correlations -> هاماتریس همبستگی آیتم  > OK 

 ( :4) خروجی

 

Reliability Statistics 

Cronbach's Alpha 

Cronbach's Alpha Based on 

Standardized Items N of Items 

.886 .885 7 

 

 :  Reliability Statisticsتحلیل جدول 

 انیهمس اصلی شاخص عنوان به را کرونباخ آلفای و دهد می ارائه را پرسشنامه کلی پایایی خلاصه جدول این

 .دهد می نشان درونی

باشد، پایایی قابل قبول تا خوب  9/4تا 7/4مقدار کلی آلفا اگر بین ، Nunnally & Bernstein, 1994 طبق

   دهنده نشان و است عالی پایایی بیانگر، که  Cronbach's Alpha=0.886. در جدول داریم : است

 ،است خام آلفای به نزدیک Standardized Alpha = 0.885. است GAD-7 آیتم 7 بین بالا هماهنگی

 GAD-7 ساختار با N of Items = 7. است( یکسان لیکرت) ها آیتم مقیاس زیاد تأثیر عدم دهنده نشان که

، کندمی معتبر پزشکی دانشجویان در اضطراب غربالگری برای را GAD-7 ،پایایی مقدار این. دارد همخوانی

 اییپای جدول این .یابد کاهش کمی( اول سال دانشجویان مانند) پایین واریانس با های گروه در است ممکن اما

 .کندمی برجسته پرسشنامه قوت نقطه عنوان به را کلی
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 ( :2) خروجی

Item Statistics 

 Mean Std. Deviation N 

gad1 1.20 .864 759 

gad2 1.06 .947 759 

gad3 1.14 .914 759 

gad4 1.07 .853 759 

gad5 .80 .859 759 

gad6 1.00 .852 759 

gad7 .60 .807 759 

 

 : Item Statisticsتحلیل جدول 

 ای برای تحلیل همسانی است. دهد و پایه را نشان می GAD-7های  این جدول آمار توصیفی آیتم

میانگین مقدار دهنده سطح اضطراب خفیف تا متوسط در نمونه است ) ( نشان24/4تا 74/4میانگین نمرات )

که با  ،میانگین بالاتری دارند gad3 (1.14)و  gad1 (1.20)که در حد خفیف است(.  ،24 از 18/7 ~کل 

 gad7 (0.60)در حالی که  د،دارقراری و نگرانی( در دانشجویان پزشکی همخوانی ها )بی اهمیت این آیتم

 باشد. در این گروه جوان"رس از اتفاق بدت "که ممکن است به دلیل کمتر شایع بودن، تری دارد میانگین پایین

که برای همبستگی درونی مناسب  ،دهنده پراکندگی متوسط است ( نشان917/4تا  847/4انحراف استاندارد )

برای همه  N=759کند(. پایایی را تقویت می این که مشاهده می شود، ها نزدیک به هم است )واریانس آیتم

 (.حذف داده های گمشده به دلیل 777رکورد از  47ای کامل است )کاهش ه دهنده داده ها نشان آیتم

که ممکن است به دلیل جمعیت دانشجویی با اضطراب  ،کنداین جدول توزیع پایین نمرات را برجسته می

 غیرشدید باشد.
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 ( :9خروجی )

Inter-Item Correlation Matrix 

 gad1 gad2 gad3 gad4 gad5 gad6 gad7 

gad1 1.000 .730 .667 .589 .427 .474 .499 

gad2 .730 1.000 .790 .641 .426 .505 .550 

gad3 .667 .790 1.000 .624 .409 .491 .496 

gad4 .589 .641 .624 1.000 .511 .497 .452 

gad5 .427 .426 .409 .511 1.000 .423 .347 

gad6 .474 .505 .491 .497 .423 1.000 .425 

gad7 .499 .550 .496 .452 .347 .425 1.000 

 

 : Inter-Item Correlation Matrixتحلیل جدول 

 دهد و پایه همسانی درونی است. میرا نشان  GAD-7های  دوی آیتمبه های دو این ماتریس همبستگی

     خوب بین  دهنده هماهنگی که نشان، ( هستند794/4تا  917/4ها مثبت و متوسط تا قوی ) همبستگی

همبستگی بالایی  gad3و  gad2برای جلوگیری از همپوشانی بیش از حد(.  9/4-7/4ها است )استاندارد  آیتم

 gad5و gad1با  gad7در حالی که  ،کنددر اضطراب عمومی را تأیید می "نگرانی"که اهمیت  ،دارند

تر ممکن است به  پایینهای  دهد. همبستگی را نشان می gad7که ضعف نسبی  ،همبستگی متوسط دارد

پایایی 5/4 ~از سایر علائم اضطراب در دانشجویان باشد. میانگین همبستگی کل ماتریس  "ترس "دلیل تمایز 

را  gad7اما  ،کندرا تأیید می GAD-7این ماتریس ساختار یکنواخت درکل  دهد. میرا توضیح  887/4

 کند. میتر برجسته  عنوان آیتم ضعیفبه

 ( :1) خروجی

Item-Total Statistics 

 

Scale Mean if Item 

Deleted 

Scale Variance if 

Item Deleted 

Corrected Item-

Total Correlation 

Squared Multiple 

Correlation 

Cronbach's Alpha 

if Item Deleted 

gad1 5.67 16.223 .739 .584 .862 

gad2 5.81 15.266 .804 .723 .852 

gad3 5.74 15.744 .763 .661 .858 

gad4 5.80 16.416 .719 .528 .864 

gad5 6.07 17.555 .531 .314 .887 

gad6 5.87 17.185 .595 .358 .879 

gad7 6.27 17.504 .586 .353 .880 
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 :Item-Total Statistics تحلیل جدول 

ها  و امکان ارزیابی تأثیر حذف آیتمدهد این جدول همسانی درونی هر آیتم با نمره کل پرسشنامه را نشان می

در حالی که  ،هستنددهنده هماهنگی خوب  نشان 5/4بالای  4کل-کند. مقادیر همبستگی آیتمرا فراهم می

Squared Multiple Correlation (R² ) کند. آلفای  شده را توصیف می داده واریانس توضیحآیتم با کل

 ضعیف مفید است. های حذف آیتم نیز برای شناسایی آیتم

Corrected Item-Total Correlationدهد. ها را نشان می: همبستگی هر آیتم با مجموع بقیه آیتم

 مطلوب است. 1/4تا  9/4دیر بالای مقا

Cronbach’s Alpha if Item Deletedآن آیتم ممکن است ، : اگر حذف یک آیتم آلفا را افزایش دهد

 ضعیف باشد.

ها )احساس  دهنده نقش کلیدی این آیتم که نشان ،قوی است gad4تا  gad1کل برای -همبستگی آیتم

     مشکل آرام شدن( در ساختار اضطراب عمومی است. ،بیش از حدنگرانی  ،کنترل نگرانی ،قراریبی

Squared Multiple Correlation  برایgad2 (0.723) آیتم را با  یانس اینوار %72که ، بالاترین است

 کند.دهد و اهمیت آن را در دیتاست دانشجویان برجسته می کل توضیح می

 gad5 (0.531)و gad6 (0.595)  وgad7 (0.586) که ممکن است به دلیل  ،همبستگی متوسط دارند

باشد. جوان ترس از اتفاق بد( در نمونه  ،پذیری تحریک ،قراری شدید کمتر شایع بودن این علائم )بی

Squared Multiple Correlation  پایینgad7 (0.353) 75نشده داده  دهنده واریانس توضیح نشان% 

 کند.که ضعف نسبی این آیتم را برجسته می ،است

که پیشنهاد  ،( است887/4بالاتر از آلفای کل ) gad7 (0.880)و  gad5 (0.887)آلفای حذف آیتم برای 

ده دهن ( نشان44/4اما تفاوت کوچک )کمتر از  ،بخشد کمی بهبود میها پایایی را  کند حذف این آیتممی

 آیتمی است. 7لزوم حفظ ساختار 

 

سازی  را برای بومی gad7و  gad5های  اما آیتم ،کندول پایایی کلی را تأیید میاین جد تحلیل کلی:

 دهد. تر نشان می فرهنگی )مثلاً در جوامع دانشجویی( ضعیف

 که، کنندمی  تأیید قوی تا متوسط های همبستگی و 887/4 آلفا با را GAD-7 عالی پایایی هاخروجی

  gad4 تا gad1 های آیتم. کندمی معتبر پزشکی دانشجویان در اضطراب غربالگری برای را پرسشنامه
                                                           

1 Corrected Item-Total Correlation 
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 .باشند داشته اصلاح به نیاز است ممکن و ترند ضعیف gad7 و gad5, gad6 که حالی در ،هستند ترینقوی

 . است خفیف اضطراب توزیع دهنده نشان و است سازگار 759 حجم با نتیجه این

 

 یسازروش نصف -

 کندمی تقسیم نیمه دو به را GAD-7 پرسشنامه که است پایایی ارزیابی های روش از یکی سازی نصف روش

 دیتاست برای روش این. کند بررسی را ابزار درونی ثبات تا ،کندمی محاسبه را نیمه دو نمرات بین همبستگی و

 . کندمی  تولید پایداری نتایج و ندارد طولی های داده به نیازی زیرا ،است مناسب پژوهش ما

  ها داده سازیآماده( 4

 گمشده های داده( مدیریت 2

 نیمه دو به ها آیتم تقسیم( 9

GAD-7 بر یمتقس اینبه صورت زیر آن را به دو نیمه تقسیم می کنیم.  پس .(فرد تعداد) است آیتم 7 دارای 

 .شودمی امانج( جسمانی علائم برای ها بعدی. نگرانی برای ها آیتم اولین) بالینی اهمیت و ها آیتم ترتیب اساس

 gad1, gad2, gad3, gad4 : اول نیمه

  gad5, gad6, gad7: دوم نیمه

 

 : اول نیمه نمره محاسبهمسیر 

Transform > Compute Variable > Target Variable: Half1_Score > Numeric 

Expression: gad1 + gad2 + gad3 + gad4 > OK > اول  نیمه نمرات با جدید ستون ایجاد  

 

 : دوم نیمه نمره محاسبهمسیر 

Transform > Compute Variable > Target Variable: Half2_Score > Numeric 

Expression: gad5 + gad6 + gad7 > OK >  دوم نیمه نمرات با جدید ستونایجاد  
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 نیمه دو بین همبستگی محاسبه( 1

 :مسیر

 Analyze > Correlate > Bivariate > Variables : Half1_Score, Half2_Score > 

Correlation Coefficients : Pearson > Test of Significance: Two-tailed, Flag 

significant correlations > OK 

 (Half2_Score, p-value و Half1_Score بین r) همبستگی ماتریس : خروجی

 

Correlations 

 Half1_Score Half2_Score 

Half1_Score Pearson Correlation 1 .709** 

Sig. (2-tailed)  .000 

N 759 759 

Half2_Score Pearson Correlation .709** 1 

Sig. (2-tailed) .000  

N 759 759 

**. Correlation is significant at the 0.01 level (2-tailed). 

 : Correlationsتحلیل جدول 

،   Half2_Score وHalf1_Score   شامل GAD-7 پرسشنامه نیمه دو نمرات بین همبستگی جدول

    مکزیکی پزشکی دانشجویان دیتاست در را ابزار درونی ثبات که است سازی نصف روش کلیدی خروجی

 پیوند دهنده نشان ،  444/4داری معنی سطح با ،نیمه دو بین 749/4 پیرسون همبستگی. کندمی  ارزیابی

    مقدار این. دهد می پوشش را مشترک واریانس( r²=0.503) % 9/54 که هاست آیتم پایدار و قوی

 آستانه از ،شده محاسبه( داده  777 ازداده های گمشده  حذف از پس) 759 نمونه حجم در که ،همبستگی

 روانی/جسمانی علائم و( اول نیمه) اولیه نگرانی های جنبه بین هماهنگی و رفته فراتر درونی همسانی برای 5/4

 .سازدمی  برجسته را( دوم نیمه)

 خام همبستگی که شودمی  اعمال Spearman-Brown ضریب ،پرسشنامه کل پایایی برآورد و تعدیل برای

 دتأیی تحصیلی استرس با دانشجویان گروه در را ابزار خوب پایایی مقدار این و دهد می افزایش 89/4 به را

 عدم دهنده نشان متوسط همبستگی اما ،کرده ایجاد بالایی آماری حساسیت 759 نمونه حجم. کندمی

 نیمه و 8/2 ~ اول نیمه نمرات میانگین) جمعیت این در اضطراب علائم تنوع از که، است کامل همپوشانی

؛ سازدمی معتبر مشابه جوامع در اضطراب غربالگری برای را GAD-7 ،نتیجه این. شودمی  ناشی( 8/4 ~ دوم
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 gad1, gad3, gad5, gad7 مانند) بالینی اهمیت اساس بر ها آیتم تقسیم شود می پیشنهاد هرچند

 .شود تست تعدیل بهبود برای( ,gad2 gad4, gad6و

 : Spearman-Brown فرمول با تعدیل( 5

 :می کنیم  محاسبهزیر،  Spearman-Brown فرمولگرفته و به وسیله  خروجی از را( r) خام همبستگی

𝑟𝑏𝑠 =
2𝑟

𝑟 + 1
= 0.829 

 : SPSS مسیر در

Transform > Compute Variable > Target Variable: SB_Coefficient >  Numeric 

Expression: (2 * r) / (1 + r) { جایگزین می کنیم 749/4آن یعنی  را با مقدار واقعی  r} > OK  

 .است 829/4و مقدار آن  شود می ایجاد جدید ستون یک در شده تعدیل ضریب

 

 : پیشنهادی مسیر نمودار

Graphs > Chart Builder > Scatter/Dot > Simple Scatter > X-Axis: Half1_Score ,          

Y-Axis: Half2_Score > OK >  همبستگی پراکندگی نمودار    

 خروجی : 
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 تحلیل نمودار :

 الگوی پراکندگی -

درجه )خط همبستگی( قرار دارند، که  15شده در امتداد خط  صورت یک خوشه کشیده نقاط در نمودار به 

شده  بین نمرات نیمه اول و نیمه دوم است. این الگو با همبستگی گزارش دهنده رابطه مثبت و خطی نشان

 کند. میواریانس مشترک را منعکس  ٪ 9/54همخوانی دارد و  749/4

 توزیع نقاط -

قریباً ت دهنده واریانس متوسط است، که با انحراف استاندارد نمرات ) پراکندگی نقاط حول خط رگرسیون نشان

    ~ Half1_Score ) ( سازگار است. تراکم بیشتر نقاط در محدوده نمرات پایین هابرای آیتم 4/4تا  8/4

    ( با میانگین اضطراب خفیف تا متوسط در دانشجویانHalf2_Score ~ 4/2-5/4 و 4/9-5/2

(GAD_Total ~ 7.5هم ) .راستاست 

 Spearman-Brownضریب  -

صورت نزدیکی نقاط به خط آید، که در نمودار به میدست  به89/4، ضریب 749/4با تعدیل همبستگی خام 

       دهنده ثبات درونی قوی کند و نشانرگرسیون قابل مشاهده است. این مقدار پایایی خوب را تأیید می

GAD-7 .است 

 نقاط پرت -

ن در یک نیمه و پایین در نیمه دیگر(، ممک 1اگر نقاطی خارج از خوشه اصلی دیده شوند )مثلاً نمره بالای 

های ناسازگار یا ناهمگنی در برخی افراد )مثلاً دانشجویان با استرس شدید( باشد، که  دهنده پاسخ است نشان

 قابل اغماض است. 759با حجم 

   دهد، جایی که میخوبی نشان  را به GAD-7های  هماهنگی بین نیمه نموداربه طور کل می توان گفت، 

    طور معناداری قراری )نیمه اول( با علائم جسمانی و روانی )نیمه دوم( به های مربوط به نگرانی و بی آیتم

دهد و ابزار را برای  می، پایایی را در سطح قابل قبول تا عالی قرار 89/4شده  راستا هستند. ضریب تعدیل هم

ن میانگی سازد. با این حال، پراکندگی نسبی نقاط و تفاوت در میسنجش اضطراب در این جمعیت معتبر 

های  سازی در جمعیت نمرات دو نیمه ممکن است به تفاوت فرهنگی یا شدت علائم اشاره کند، که برای بومی

 .دیگر نیاز به بررسی دارد
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  بازآزمون - روش آزمون -

 دهد می نشان و کندمی بررسی را GAD-7 مانند یریاندازه گ ابزار یک زمانی ثبات 4بازآزمون-آزمون روش

 های دادهدیتاست پژوهش ما،  که آنجا از. خیر یا مانند می باقی پایدار مختلف زمانی های بازه در نمرات آیا که

 اییابتد های ترم مثلاً) دیتاست در موجود های زیرگروه اساس بر سازی شبیه با روش این ندارد، واقعی طولی

 نمرات میانگین های تفاوت که کندمی فرض سازیشبیه این. شود می اجرا( 8 تا 5 بعدی های ترم و 1 تا 4

GAD_Total بین یهمبستگ ضریب. شود تفسیر زمانی ثبات تخمین یک عنوان به تواندمی ها گروه این بین 

 .شود تلقی قبول قابل پایایی تا باشد 7/4 بالای باید ها زیرگروه این نمرات

 ها داده سازیآماده( 4

 ها زیرگروه به ها داده تقسیم( 2

 1 تا 4 ابتدایی های ترم - 4 زیرگروه -

 :مسیر

 Data > Select Cases > If condition is satisfied >  شرط : (semester >=1 AND      

semester <=  4) > Copy to a new dataset > جدید دیتاست نام  : Early_Terms > OK 

 8 تا 5 بعدی های ترم – 2 رگروهزی -

 :مسیر

Data > Select Cases > If condition is satisfied >  شرط : (semester >=5 AND      

semester <=  8) > Copy to a new dataset > جدید دیتاست نام  : Late_Terms > OK 

 .است فرضی زمان دو در بازآزمون سازیشبیه که کندمی ایجاد جداگانه دیتاست دو کار این

 استاندارد انحراف و میانگین محاسبه( 9

 :دیتاست هر برایمسیر 

Analyze > Descriptive Statistics > Descriptives > Variables: GAD_Total > Options: 

Mean, Std. Deviation > OK 

                                                           
1 Test-Retest Reliability 
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 .دهد می نشانبه صورت جداگانه  گروه هر برای را GAD_Total استاندارد انحراف و میانگین کار این

 خروجی:

 [Early_Terms]  

Descriptive Statistics 

 N Mean Std. Deviation 

GAD_Total 451 7.51 4.896 

Valid N (listwise) 451   

 
 

[Late_Terms]  

Descriptive Statistics 

 N Mean Std. Deviation 

GAD_Total 313 5.94 4.220 

Valid N (listwise) 313   

 :Descriptive Statisticsتحلیل جدول های 

  GAD_Late ≈ 6.8 میانگین،  SD ≈ 4.0و  GAD_Early  6.2 ≈ میانگین : استاندارد انحراف و میانگین

 های ترم استرس به که واحدی 0.6 اندک افزایش با است، اضطراب نسبی ثبات دهنده نشان  ≈ SD  4.2و

 . است مرتبط بالاتر

 دهندهنشان  و است سازگار( GAD_Total ≈ 6.5) متوسط تا خفیف میانگین با( SD ≈ 4) متوسط پراکندگی

 .است پزشکی دانشجویان در طبیعی توزیع

 مقایسه برای ها دیتاست ادغام( 1

 می کنیم. باز اصلی دیتاست عنوانبه را Early_Terms دیتاست

Data > Merge Files > Add Variables > Merge Files > An open dataset: Early_Terms 

> Add a dataset: Late_Terms.sav > OK  

 زیرگروه دو بین همبستگی محاسبه( 5

 .می کنیم باز را Merged_Data دیتاست

Analyze > Correlate > Bivariate > Variables: GAD_Total_Early, GAD_Total_Late > 

Correlation Coefficients: Pearson > Test of Significance: Two-tailed, Flag 

significant correlations > OK 
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 .شودمی تولید گروه دو نمرات بین همبستگی ماتریسخروجی : 

Correlations 

 GAD_Total_Early GAD_Total_Late 

GAD_Total_Early Pearson Correlation 1 .087 

Sig. (2-tailed)  .123 

N 451 313 

GAD_Total_Late Pearson Correlation .087 1 

Sig. (2-tailed) .123  

N 313 313 

 

 :  Correlationsتحلیل جدول 

 داریمعنی سطح پیرسون، همبستگی های آماره و GAD_Late و GAD_Early متغیر دو شامل جدول

 : دباشنمی زیر شرح به مقادیر. است مشاهدات تعداد و( Sig. 2-tailed) دوطرفه

GAD_Late GAD_Early  

0.087 1.000 GAD_Early 

1.000 0.087 GAD_Late 

313 451 N 

0.123 0.123 Sig. 

در این قسمت برای بررسی پایایی بازآزمون پرسشنامه، داده ها بر اساس ترم تحصیلی به دو گروه مستقل 

این دو مجموعه به تقسیم شدند. از آنجا که داده ها زوجی نبودند و شبیه سازی انجام شد، همبستگی بین 

 صورت مستقل محاسبه می شد تا میزان ثبات نسبت به نمرات در دو زمان بررسی شود.

 مقدار و است بوده r = 0.087 بعدی نمرات و اولیه نمرات بین پیرسون همبستگی ضریب که داد نشان نتایج

 و است بوده 0.05 معناداری سطح از تر بزرگ مقدار این. است p = 0.123 با برابر اول نوع خطای احتمال

 . نیست معنادار آماری نظر از دلیل همین به

. دارد جودو غیرمعناداری و ضعیف بسیار مثبت همبستگی ترم، دو نمرات بین که است آن بیانگر ها یافته این

. است نشده تکرار مشابه صورتبه زمانی بازه دو در( GAD) فراگیر اضطراب نمرات در تغییرات دیگر، عبارت به
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 تفاوت یا طیمحی شرایط تفاوت تحصیلی، ترم دو بین ها نمونه ترکیب در تفاوت ایجاد باعث تواندمی نتیجه این

 .باشد ترم هر افراد های ویژگی در

 ثبات ی دهندهنشان  نتیجه هستند، متفاوت دوره دو در کنندگان شرکت و نبوده زوجیداده ها  که جاآن از

 . زمان طول در فردی نمرات ثبات نه است، گروهی سطح در ها کلی

در کل می توان گفت به علت خصوصیات داده ها، بهتر بود از این روش استفاده نشود. نتایج هم به گونه ای 

 این مطلب را تایید می کنند.

 

  نمودار ایجاد( مسیر 7

Graphs > Chart Builder > Scatter/Dot > Simple Scatter > X-Axis: GAD_Total_Early, 

Y-Axis: GAD_Total_Late > OK  

 .دهد می نمایش را ثبات الگوی پراکندگی نمودار: خروجی 
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  ارزی روش هم -

کند و همبستگی نمرات را  میرا با مقایسه آن با فرم موازی یا ابزارارزیابی  GAD-7پایایی  4یارز همروش  

دیتاست پژوهش در  GAD-7گیرد. از آنجا که فرم موازی مستقیم  میعنوان شاخص ثبات درونی در نظر  به

( و GAD-7)نمره کل  GAD_Totalسازی از طریق همبستگی  موجود نیست، این روش با شبیهما 

PHQ_Total  نمره کل(PHQ-9اجرا می )  شود، زیرا افسردگی و اضطراب همبودی بالایی دارند وPHQ-9 

 باشد تا پایایی قابل قبول باشد.  5/4کند. ضریب همبستگی پیرسون باید بالای می عنوان ابزار مشابه عمل  به

 ها سازی دادههآماد( 4

 : PHQ_Totalو  GAD_Totalمسیر محاسبه 

1. Transform > Compute Variable > Target Variable: GAD_Total > Numeric 

Expression: gad1 + gad2 + gad3 + gad4 + gad5 + gad6 + gad7 > OK 

2. Transform > Compute Variable >  Target Variable: PHQ_Total > Numeric 

Expression: phq1 + phq2 + phq3 + phq4 + phq5 + phq6 + phq7 + phq8 + phq9 > 

OK  

 PHQ_Totalو  GAD_Totalمحاسبه همبستگی بین ( 2

  مسیر: 

Analyze > Correlate > Bivariate > Variables: GAD_Total, PHQ_Total > Correlation 

Coefficients : Pearson > Test of Significance > Two-tailed , Flag significant 

correlations > OK 

 : خروجی

Correlations 

 GAD_Total PHQ_Total 

GAD_Total Pearson Correlation 1 .682** 

Sig. (2-tailed)  .000 

N 763 761 

PHQ_Total Pearson Correlation .682** 1 

Sig. (2-tailed) .000  

N 761 761 

**. Correlation is significant at the 0.01 level (2-tailed). 

                                                           
1 Parallel Forms Reliability 
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 : Correlationsجدول تحلیل 

 داریمعنی  سطح، پیرسون همبستگی های آماره و( PHQ_Total و GAD_Total) متغیر دو شامل جدول

 :هستند زیر شرح به جدول مقادیر. است مشاهدات تعداد و ،(Sig. 2-tailed) دوطرفه

 GAD_Total PHQ_Total 

GAD_Total 1.000 0.682** 

PHQ_Total 0.682** 1.000 

N 763 761 

Sig. - 0.000 

 این. است PHQ_Total و GAD_Total بین قوی و مثبت رابطه دهنده نشان 782/4 مقدار: 4همبستگی

( GAD-7) اضطراب توجه قابل همبودی دهنده نشان که دهد، می توضیح را مشترک واریانس ٪ 5/17 مقدار

 .است دانشجویان در( PHQ-9) افسردگی و

 سطح در آماری داری معنی دهنده نشان**  علامت با( 0.001 از کمتر) p=0.000  :2داریمعنی سطح

 .کندمی  تأیید را رابطه به بالا حساسیت نتیجه این. است 0.01

 و GAD-7 زیرا ،(5/4 < استاندارد) کندمی تأیید را قبول قابل پایایی 782/4 همبستگی: ارزی هم پایایی

PHQ-9 های میانگین با مقدار این. کنندمی  عمل( روان سلامت برای دو هر) مرتبط ابزارهای عنوان به 

 منعکس را پزشکی دانشجویان در افسردگی و اضطراب ٪25_94 همبودی و است سازگار فرضی توصیفی

 .کندمی

 توضیح GAD_Total توسط PHQ_Total واریانس ٪5/17 که دهدمی  نشان = r²  0.465:رابطه قدرت

 ممکن مانده باقی واریانس ٪5/59 حال، این با. است مناسب ارزی هم سازی شبیه برای که شود،می  داده

 .باشد مربوط محیطی عوامل یا( PHQ-9در آیتم 9و  GAD-7در آیتم 7) ابزارها ساختاری های تفاوت به است

 از توانمی  مقایسه، برای اما ندارد، نیاز تعدیل فرمول به تنهایی به ارزی هم ضریب: استانداردها با مقایسه

 .کندمی  تقویت را خوب پایایی که ،(𝑟 𝑠𝑏) کرد استفاده Spearman-Brown فرمول

 

                                                           

1 Pearson Correlation 
2 Sig. 2-tailed 
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 خلاصه فرآیند پژوهش

عنوان ابزاری برای غربالگری اضطراب در  به GAD-7سنجی پرسشنامه  این پژوهش با هدف ارزیابی روان

درجه ای است  1سوال با مقیاس لیکرت  7پرسشنامه پژوهش، شامل  .دانشجویان پزشکی مکزیکی انجام شد

 777دیتاست مورد استفاده شامل و به سنجش شدت علائم اضطراب عمومی در دو هفته گذشته می پردازد. 

 ها با استفاده از نرم های گمشده، حجم نمونه کاهش یافت. تحلیل داده با اعمال پاک سازی دانشجو بود که

 . ندهای مختلف پایایی و روایی بود اجرا شدند و شامل بررسی جنبه 27نسخه  SPSSافزار 

با روش های گفته شده و مطابق با خصوصیات  روایی ملاکیروایی محتوایی، روایی سازه و در بخش روایی، 

 ( وCVR) شاخص های ارزیابی ضروری بودن آیتم هاروایی محتوایی، دیتاست، بررسی و تحلیل شد. برای 

( و تحلیل EFAو برای روایی سازه، شاخص های تحلیل عاملی اکتشافی ) (CVI) ارزیابی مرتبط بودن آیتم ها

 GAD_Total بین خطی رگرسیون تحلیل بامحاسبه و تحلیل گردید. در روایی ملاکی،  ،(CFAعاملی تاییدی )

  .ل شدنتایج حاص( تحصیل ترک افکار) "thoughts_of_dropping_out" مستقل متغیر و

 gad7تا  gad1های  در بخش پایایی، ابتدا آلفای کرونباخ برای ارزیابی همسانی درونی محاسبه شد، که آیتم

با  سازی گرفت. سپس روش نصفو ترس از اتفاق بد( را در بر می نگرانیقراری، کنترل  )شامل احساس بی

ها انجام شد.  محاسبه همبستگی بین آن( و gad5-gad7و  gad1-gad4تقسیم پرسشنامه به دو نیمه )

( و مقایسه نمرات 5-8و  4-1) های تحصیلی سازی بر اساس ترم بازآزمون نیز با شبیه-روش آزمون

GAD_Early  وGAD_Late میانارزی با استفاده از همبستگی  اجرا گردید. همچنین، روش هم 

GAD_Total  وPHQ_Total سازی شد.  موازی فرضی پیاده عنوان فرم )ابزار افسردگی( به 

ها با دقت آماری بالا و با در نظر گرفتن حجم نمونه مناسب و میانگین نمرات اضطراب  هر یک از این روش

(GAD_Total ≈ 6.87انجام پذیرفت. داده ) های توصیفی و ها با مدیریت دقیق و استفاده از تکنیک   

 تکمیل شدند. مانند پراکندگی گرافیکی

 

 بحث و نتایج

 آن که است، خاص جمعیت این در GAD-7 قوی تا قبول قابل روایی و پایایی دهنده نشان پژوهش این نتایج

 887/4 با مقدار کرونباخ آلفای پایایی، بخش در. کندمی تبدیل اضطراب غربالگری برای معتبر ابزاری به را

 های یتمآ حال، این با. بود سازگار کل - آیتم همبستگی با و است عالی درونی همسانی بیانگر که آمد، دستبه

gad5 (شدید قراری بی )و gad7 (بد اتفاق از ترس )نشان نسبی ضعف( 587/4 و594/4) تر پایین ضریب با 

 با ازیس نصف روش. باشد مرتبط دانشجویان در علائم شدت یا فرهنگی های تفاوت به است ممکن که دادند،



97 
 

 قوی درونی ثبات ،Spearman-Brown 894/4  شدهتعدیل ضریب مقدار و 749/4 همبستگیمقدار ضریب 

 نبی همبستگی با بازآزمون – آزمون. نمود منعکس را یکنواخت الگوی ،پراکندگی نمودار و کرد تأیید را

GAD_Early و GAD_Late،  پیشرفت با 7.8 به 7.2 از میانگین افزایش اگرچه داد؛ نشان را زمانی ثبات 

 GAD_Total بین 782/4 همبستگیمقدار ضریب  با ارزی هم روش. داشت اشاره تحصیلی استرس به، ها ترم

 .ساخت برجسته را افسردگی و اضطراب ٪ 5/17 همبودی و کرد تأیید را قبول قابل پایایی ،PHQ_Total و

          طور به GAD-7 که داد نشان >p  0.001و =R²  0.080با خطی رگرسیون تحلیل روایی، بخش در

 751 نمونه حجم و( B ≈ 3.36) مثبت شیب با که کند،می بینی پیش را تحصیل ترک افکار دار معنی

 نقش دهندهنشان واریانس ٪8 توضیح اما کند،می تأیید را متوسط ملاکی روایی نتیجه، این. دارد همخوانی

 را رهامتغی بین خطی رابطه نیز پراکندگی نمودارهای. است اجتماعی حمایت یا روانی فشار مانند دیگر عوامل

 .داد نسبت افراد برخی در احتمالی ناهمگنی به را پرت نقاط و کرد بصری

 بحث

 بالای پایایی و هستند راستا هم GAD-7 برای Spitzer et al., 2006 مانند قبلی مطالعات با ها یافته این 

 بار هب است ممکن بالاتر های ترم در نمرات افزایش حال، این با. کنندمی  تأیید مشابه های جمعیت در را 8/4

( gad7 و gad5) ها آیتم برخی ضعف. دارد طولی بررسی به نیاز که باشد، مربوط امتحانات استرس یا آموزشی

 یتمحدود. متفاوت اجتماعی ساختار با جوامع در ویژه به باشد؛ داشته نیاز فرهنگی سازی بومی به تواندمی 

. دهد می کاهش حدی تا را دقت که است، ارزیهم و بازآزمون-آزمون در فرضی سازی شبیه از استفاده اصلی،

 نیازمند دیگر های جمعیت به تعمیم اما کند،می تقویت را نتایج اعتبار آماری، داریمعنی و نمونه حجم

 .است بیشتر مطالعات

 کلی گیرینتیجه

 GAD-7 به و داد نشان مکزیکی پزشکی دانشجویان میان در را قبولی قابل روایی و پایایی پژوهش این در 

 و ولیط های داده با آینده تحقیقات شود می پیشنهاد. شد تأیید اضطراب غربالگری برای مؤثر ابزاری عنوان

 های ریزی هبرنام در بالایی پتانسیل بومی، تنظیمات با ابزار این. بخشند بهبود را نتایج این واقعی، موازی فرم

 .خواهد کرد کمک اضطراب بار کاهش به و دارد دانشگاهی روان سلامت
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